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This module includes the following Learning Guides 

LG 38: Use appropriate word-processing software 

LG Code: EIS IDC2 M10 LO1-LG-38 

LG39: Customize basic settings and format documents to  

          meet page layout conventions 

LG Code: EIS IDC2 M10 LO2-LG-39 

LG40: Create tables and add images to word document 

LG Code: EIS IDC2 M10 LO3-LG-40 

LG 41: Use appropriate spreadsheet software 

LG Code: EIS IDC2 M10 LO4-LG-41 

LG 42: Incorporate object and chart in spreadsheet 

LG Code: EIS IDC2 M10 LO5-LG-42 

LG 43: Create database 

LG Code: EIS IDC2 M10 LO6-LG-43 

LG 44: Create reports and forms 

LG Code: EIS IDC2 M10 LO7-LG-44 

LG 45: Retrieve information 

LG Code: EIS IDC2 M10 LO8-LG-45 

LG 46: Print documents 

LG Code: EIS IDC2 M10 LO9-LG-46 
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This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics –  

 Selecting appropriate word-processing software 

 Open word-processing application, create document and add data 

 Identifying document purpose and requirement 

 Identifying organisational requirements for text-based business document. 

 Designing document structure and layout  

This guide will also assist you to attain the learning outcome stated in the cover page. 

Specifically, upon completion of this Learning Guide, you will be able to – 

 Select appropriate word-processing software 

 Open word-processing application, create document and add data 

 Identify document purpose and requirement 

 Identify organisational requirements for text-based business document. 

 Design document structure and layout  

 

Learning Instructions:  

1. Read the specific objectives of this Learning Guide.  

2. Follow the instructions described below  

3. Read the information written in the ―Information Sheets 1- 6‖. Try to understand what are 

being discussed.  

4. Accomplish the ―Self-checks1, 2, 3, 4, 5 and 6‖ in each information sheets on pages 4, 

11,14,19,23 and 26. 

5. Ask from your teacher the key to correction (key answers) or you can request your 

teacher to correct your work. (You are to get the key answer only after you finished 

answering the Self-checks).  

6. If you earned a satisfactory evaluation proceed to ―Operation sheets 1, 2 and 3 on pages 

28,29 and 30.and do the LAP Test on page 31‖.  However, if your rating is unsatisfactory, 

see your teacher for further instructions or go back to Learning Activity.  

7. After you accomplish Operation sheets and LAP Tests, ensure you have a formative 

assessment and get a satisfactory result; then proceed to the next LG. 

Instruction Sheet Learning Guide 38:  Use appropriate word-processing software 
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Information Sheet-1 Selecting appropriate word-processing software 

1.1. Word Processing software 

Word processing software is used to manipulate a text document, such as a resume or a 

report. You typically enter text by typing, and the software provides tools for copying, deleting 

and various types of formatting. Some of the functions of word processing software include: 

 Creating, editing, saving and printing documents. 

 Copying, pasting, moving and deleting text within a document. 

 Formatting text, such as font type, bolding, underlining or italicizing. 

 Creating and editing tables. 

 Inserting elements from other software, such as illustrations or photographs. 

 Correcting spelling and grammar. 

Word processing includes a number of tools to format your pages. For example, you can 

organize your text into columns, add page numbers, insert illustrations, etc. However, word 

processing does not give you complete control over the look and feel of your document. When 

design becomes important, you may need to use desktop publishing software to give you more 

control over the layout of your pages. Word processing software typically also contains features 

tomake it easier for you to perform repetitive tasks. 

1.2. Types of word-processing software 

There are a number of different word processing applications. One of the most widely used 

ones is Word, which is part of Microsoft Office. Another widely used one is WordPerfect by the 

Corel Corporation. 

 Apple iWork is an applications created by Apple Inc. for its mac OS and iOS operating 

systems, and also available cross-platform through the I Cloud websites a collection of 

bundled productivity software (a software suite) intended to be used by knowledge 

workers. The components are generally distributed together, have a consistent user 

interface and usually can interact with each other, sometimes in ways that the operating 

system would not normally allow. 

 Microsoft Word One of the most well-known and widely used word processing 

applications on the market is Microsoft Word. Word can be purchased as part of the 

Microsoft Office suite of programs, which include Excel, PowerPoint, Outlook and 

Publisher. Word can be used to format text and build layout documents. 

 OpenOffice is open source and can be downloaded and used free of charge which is 

part of OpenOffice by Apache. 

 

 

https://en.wikipedia.org/wiki/Apple_Inc.
https://en.wikipedia.org/wiki/MacOS
https://en.wikipedia.org/wiki/IOS
https://en.wikipedia.org/wiki/Operating_system
https://en.wikipedia.org/wiki/Operating_system
https://en.wikipedia.org/wiki/Operating_system
https://en.wikipedia.org/wiki/ICloud
https://en.wikipedia.org/wiki/Software_suite
https://en.wikipedia.org/wiki/Knowledge_worker
https://en.wikipedia.org/wiki/Knowledge_worker
https://en.wikipedia.org/wiki/Knowledge_worker
https://en.wikipedia.org/wiki/User_interface
https://en.wikipedia.org/wiki/User_interface
https://en.wikipedia.org/wiki/User_interface
https://en.wikipedia.org/wiki/Operating_system
https://en.wikipedia.org/wiki/Operating_system
https://en.wikipedia.org/wiki/Operating_system
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1.3. Computer software 

As you know, the hardware devices need user instructions to function. A set of instructions 

that achieve a single outcome are called program or procedure. Many programs functioning 

together to does a task make software.For example, a word-processing software enables the 

user to create, edit and save documents. A web browser enables the user to view and share 

web pages and multimedia files. There are two categories of software − 

 System Software 

 Application Software 

 Utility Software 

 

Figure-1: System software 

Application software: -software that performs a single task and nothing else is 

called application software. Application software are very specialized in their function and 

approach to solving a problem. So spreadsheet software can only do operations with numbers 

and nothing else. Hospital management software will manage hospital activities and nothing 

else. Here are some commonly used application software  

 Word processing 

 Spreadsheet 

 Presentation 

 Database management 

 Multimedia tools 

 

https://en.wikipedia.org/wiki/Application_software
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Figure-2: Application system software 

System software: - which is software for managing computer hardware behavior, as to provide 

basic functionalities that are required by users, or for other software to run properly, if at all. 

System software is also designed for providing a platform for running application software. 

1.4.Operating systems 

which are essential collections of software that manage resources and provides common 

services for other software that runs "on top" of them. Supervisory programs, boot 

loaders, shells and window systems are core parts of operating systems. In practice, an 

operating system comes bundled with additional software (including application software) so 

that a user can potentially do some work with a computer that only has one operating system. 

 

 

Figure-3: operating system 

1.4.2.Device drivers 

 which operate or control a particular type of device that is attached to a computer. Each device 

needs at least one corresponding device driver; because a computer typically has at minimum 

at least one input device and at least one output device, a computer typically needs more than 

one device driver. 

 

https://en.wikipedia.org/wiki/System_software
https://en.wikipedia.org/wiki/Computer_hardware
https://en.wikipedia.org/wiki/Operating_system
https://en.wikipedia.org/wiki/Supervisory_program
https://en.wikipedia.org/wiki/Boot_loader
https://en.wikipedia.org/wiki/Boot_loader
https://en.wikipedia.org/wiki/Boot_loader
https://en.wikipedia.org/wiki/Shell_(computing)
https://en.wikipedia.org/wiki/Window_system
https://en.wikipedia.org/wiki/Device_driver
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1.4.3.Printer 

A printer is a device which is used for printing documents.  Some print in black and white, 

others color.   

 

Figure-4: Printer 

 

1.4.4. Scanner 

 A scanner is a device that lets you take a copy of a document or image.   

 

Figure-5:.scanner 

1.5.Utilities software: 

Application software that assist system software in doing their work is called utility software. 

Utility programs perform maintenance tasks on the computer system. This includes file 

management programs, uninstall programs, disk scanners and defragmenters, backup utilities, 

antivirus etc. These can be included in the OS or purchased separately Thus utility software is 

actually a cross between system software and application software. Examples of utility software 

include − 

 Antivirus software 

 Disk management tools 

https://en.wikipedia.org/wiki/Software_utility
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 File management tools 

 Compression tools 

 Backup tools 

 

 

Figure-6:.Utility software 
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Self-Check 1                                                 Written Test 

 

Direction I: Multiple choice items 

Instruction: Choose the best answer for the following questions and write the letter of your 

answer on the answer sheet provided in the next page. Use bold letter. (2 points each) 

1. One of the following is system software? 

A. Operating SystemC. Water Cad 

B. Language ProcessorD. Auto Cad 

      2. Which of the following is word processing software? 

A. Apple iWorkC. Open Office 

B.  Microsoft WordD. All of the above 

 3. Which of the following is utility software? 

A. Antivirus software            C. Compression tools 

B.  Disk management tools         D. All of the above 

 

 

 

Answer Sheet 

 

 

 

Name:  _________________________             Date:  _______________ 

Choose  

1. ____ 

2. ____ 

3. ____ 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 3 and above points           Unsatisfactory - below 3 points  

 

 

You can ask you teacher for the copy of the correct answers. 
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Information Sheet-2 Opening word process application& information requirement 

 

2.1. Introduction to opening word-processing application  

Once you‘ve created some Word documents, this method is fastest of all, since you don‘t have 

to start Word as a separate step. Just open an existing Word document, and Word starts itself.  

 Creating, Opening, and Saving Documents 

It shows you all the different ways to create a new Word document like starting from an 

existing document or adding text to a predesigned template and how to choose the best 

one for your particular project.  

You‘ll also learn how to work faster and smarter by changing your view of your 

document. If you want, you can use Word‘s Outline view when you‘re brainstorming, and 

then switch to print view when you‘re ready for hard copy.  

 Beginning Word 

The first time you launch Word after installation, the program asks you to confirm your 

name and initials. Word uses this information to identify documents that you create and 

modify.  

 Start menu. The Start button in the lower-left corner of your screen gives you access to 

all programs on your PC Word included:- 

 Quick Launch toolbar. Is at the bottom of your screen (just to the right of the Start 

menu) is a great place to start programs you use frequently. 

 Creating a New Document 

When you start Word without opening an existing document, the program gives you an empty 

one to work in. If you‘re eager to put words to page, then type away. Sooner or later, though, 

you‘ll want to start another new document. Word gives you three ways to do so: 

2.2. Creating a document from an existing document 

To start your document in any of the above ways, click the Windows logo in the upper-left 

corner of the screen. That‘s Office 2007‘s new Office button. Click it, and a drop-down menu 

opens, revealing commands for creating, opening, and saving documents. Next to these 

commands, you see a list of your Word documents. This list includes documents that are open, 

as well as those that you‘ve recently opened. 

Say you want a new blank document, just like the one Word shows you when you start the 

program. No problem here are the steps: 
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Figure-7:.Open the New Document box 

Name and save your document shortly after you first create it. You‘ll see the followingto do so 

later in this section At the bottom of the Save As dialog box, type a name in the File name box. 

Click Save. 

Word does the rest. All you need to do is remember where you saved your work. 

 

 

 

Figure-8: The Save As dialog box 

 

2.3. Types of information requirement  

Some of the major components of a business information requirement can be Agendas, letters, 

memos, minutes 

2.3.1. Notice of a Meeting 

When a meeting is to be convened, a notice is required to be sent to all who are to attend it. 

It should satisfy these conditions: 

a) It should be under proper authority 

b)  should state the name of the organization 

c)  It should state the day, date, time, and place. Also, sometimes, how to reach the place. 
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d)  It should be well in advance. Some require seven days‘ notice, some 48 hours‘ 

e) It should state the purpose and, if possible, the agenda 

f)  It should carry the date of circulation and convener‘s/secretary‘s signature 

g)  It should go to all persons required at the meet 

 

2.3.2. Agenda 

It is the list of items to be considered at a meeting. It is also called business or order of 

business. It comes from the Latin word agendum (singular) which means ‗a thing to be done.‘It 

is the route map of the meeting. The specimen notices above already contain a hint of how it is 

written. The agenda may be a part of the notice or may be attached as an annexure. The 

convener/secretary prepares it in consultation with the chairperson and gets his approval.The 

items of agenda should cover all that is necessary to be considered at that time. Meetings take 

time and effort to arrange; hence the agenda has to be well thought out. 

The items may be devised from: 

 Previous minutes 

 Suggestions received 

 Actions and events since last meeting 

 Correspondence of the organization.  

Here are some guidelines for listing the items: 

 Apologies from absent members (need not be written previously) 

 Condolences if any (may or may not be written previously) 

 Reading and approval of minutes of the last meet 

 Matters arising out of previous meet‘s minutes (this need not always be mentioned) 

 Urgent and uncontroversial items 

 Matters requiring closer discussion and debates 

 Any new, on-the-spot items with the approval of the chairman 

 Date of the next meet. 

 The last item in a meeting is a vote of thanks to the chairman but this need to be 

mentioned.  

2.4. Minutes of the Meeting 

The minutes of a meeting are the record of the discussions/decisions therein. They have an 

official status; they are useful in law, and in some cases required by law to be written. Minutes 

are final when they are approved by the members of the group to which they relate, generally in 

the next meeting, and signed by the chairperson. Even if there are emotional moments in a 
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meet, the minutes are written in an unemotional manner, are cool, factual, impersonal, and 

impartial. 

2.5. Requirements 

 The motions and amendments  

 The proposer and seconded of motions 

 The details of voting, if any 

 Recommendations 

 Decisions/ resolutions 

 Tasks assigned to individuals 
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Self-Check -2 Written Test 

 

Direction I: Multiple choice item 

Instruction: Choose the best answer for the following questions and write the letter of your 

answer on the answer sheet provided in the next page. Use bold letter. (2points 

each). 

1. Whichis trueabout precondition for notice? 

 A. It should be under proper authority                 C.Should state the name of the 

organization            

B. It should state the day, date, time, and place. D.ALL 

2._______is a consumable commodity used by human beings to support specific actions 

and/or decisions of the business.  

A. wisdom C. Information  

B. Data                                                                   D. knowledge 

 

3.The major components of a business information requirement can be 

        A. agendaC. memos 

B. LettersD. All 

 

 

 

 

Answer Sheet 

 

 

 

Name:  _________________________             Date:  _______________ 

Choose  

1____ 

2____ 

3____ 

 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 3 and above points           Unsatisfactory - below 3 points  

 

 

You can ask you teacher for the copy of the correct answers. 
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Information Sheet-3 Identifying document purpose and requirement 

 

3.1. Identification of Purposes of documents 

Documents should be created for purposes or goals that both the writer and the reader would 

readily agree on. Although there are many explicit purposes for creating a scientific or technical 

document, there are four general categories: to provide information, to give instructions, to 

persuade the reader, and to enact (or prohibit) something. 

3.2. Examples of Explicit Document Purposes  

 To provide information this document will discuss the genetic basis of muscular 

differentiation of the Mediterranean fruit fly. 

 To give instructions this document outlines a procedure for isolating the 

mechanisms of muscular differentiation in the Mediterranean fruit fly. 

 To persuade the reader this document proposes a study of the mechanisms for 

blocking muscular differentiation in the Mediterranean fruit fly. 

 

3.3.Identification of document includes:- 

 Captions 

 Different odd and even page 

 Hyperlinks 

 Document protection 

 Linked and embedded objects 

 Mail-merge data document 

 MS Word Art 

 

3.3.1.Captions 

The ―Caption‖ options in Microsoft Word allow you to label images, diagrams, charts, 

illustrations and figures so your reader can quickly identify what they mean, as well as enabling 

use of the ―dynamic‖ list functions offered by Microsoft Word. 

 

3.3.2. Different odd and even pages 

When adding the headers and footers in a Word document, they are the same on each page by 

default. If you are working on a regular report, you may not need to create different headers 

and footers on different pages. 

https://support.office.com/en-gb/article/Add-or-delete-captions-2dfedcf0-95b1-40e3-9674-96d0ee25faca
https://getproofed.com/resources/academic-blog/category/ms-word-tips/
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3.3.3. Document protection 

This wiki how teaches you how to lock a Microsoft word document with a password. You can do 

this on both windows and mac versions of Microsoft word, though you cannot password-protect 

a document from within one drive. 

 

3.3.4. Hyperlinks 

There are times when content in a document will require an external source to buttress a point 

or provide further information. This often comes in form of link to a web page. Therefore if you 

want to know what is hyper linking MS word, look no further than those links embedded in a 

text in a word document. 

 

3.3.5. Linked and embedded objects 

Is inserting another object to word document such as adobe acrobats document, bitmap image 

or excel chart. Object Linking & Embedding (OLE) is a proprietary technology developed 

by Microsoft that allows embedding and linking to documents and other objects. 

 

3.3.6. MS WordArt 

 Is adding same artistic flair to your document using the ward art Word Art is a text modifying 

feature. In Microsoft applications, including Excel, PowerPoint, and Word, users can 

add WordArt to their spreadsheet, slide, or document. WordArt is a more stylish type of text, 

allowing users to make the text more noticeable and more flashy. 

 

There are multiple varieties of text styles with WordArt, including embossed text, bordered text, 

and shadowed text. Users can add WordArt that uses two different colors, one color being the 

text border and the other color being the fill color of the text. After adding WordArt to a 

document, it can be moved to almost anywhere, and the size of the WordArt text can be 

adjusted as well. 

 

 

 

 

https://en.wikipedia.org/wiki/Proprietary_format
https://en.wikipedia.org/wiki/Microsoft
https://en.wikipedia.org/wiki/Hyperlinking
https://en.wikipedia.org/wiki/Document
https://www.computerhope.com/jargon/e/excel.htm
https://www.computerhope.com/jargon/p/powerpoi.htm
https://www.computerhope.com/jargon/m/microsoft-word.htm
https://www.computerhope.com/jargon/s/spreadsheet.htm
https://www.computerhope.com/jargon/s/slidesho.htm
https://www.computerhope.com/jargon/d/document.htm
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Self-Check -3 Written Test 

 

Direction I: Multiple choice item 

Instruction: Choose the best answer for the following questions and write the letter of your 

answer on the answer sheet provided in the next page. Use bold letter.(2 points 

each) 

1. What is the function of explicitly document? 

A. To provide information C. To persuade the reader 

B. gives instructionsD. To enact (or prohibit) something 

2. ____________ is a proprietary technology developed by Microsoft that allows embedding 

and linking to documents and other objects. 

A. Object Linking & Embedding     C. Hyperlink  

B. word art                                      D. caption  

3.  What is the basic function of caption? 

A. Position the cursor where you want the list to appear. 

B. Go to the ―References‖ tab and select ―Insert Table of Figures‖. 

C. Choose the caption label type (e.g., Figure, Table, NoneIf you‘re using more than one 

caption style, you can even create separate lists for different label types. 

D. all are correct answers  

 

 

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

Choose  

1____ 

2____ 

3____ 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 3 and above points           Unsatisfactory - below 3 points  

 

 

You can ask you teacher for the copy of the correct answers. 

 

https://en.wikipedia.org/wiki/Proprietary_format
https://en.wikipedia.org/wiki/Microsoft
https://en.wikipedia.org/wiki/Hyperlinking
https://en.wikipedia.org/wiki/Document
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Information Sheet-4 Identifying organisational requirements  

4.1. Introduction to organisational requirements 

The type and number of documents produced will depend on the nature of your organisation‘s 

business. Documents produced could include: spreadsheets and databases  a range of 

business letters and forms  email, memos and faxes  web pages  flyers, brochures, newsletters 

and business cards  reports tenders  booklets , certificates or awards. Know current and future 

requirements. 

 

To establish future needs, your first reference should be the organisational business plan. By 

referring to the business plan, you can identify whether there will be new business areas 

emerging. Secondly, consult with senior and other departmental managers to determine if the 

organisation is capable of producing such documents and whether it would be financially viable 

or cheaper to outsource this role. 

 

4.2. Types of Organisational requirements 

4.2.1. Company colour scheme 

 Warm colors. Red, yellow and orange evoke a warm feeling because they remind us of 

things like the sun or fire. 

 Cool colures. Blue, green and purple evoke cool feelings because they remind us of 

cool things like water or grass. Now that we‘ve gotten these terms out of the way, we 

can take a look at the emotional impact of color:  

 Red: One of the primary colures, red is typically associated with strong or passionate 

emotions like love, confidence, excitement and passion and has been known to make 

people hungry. On the flip side, it's also associated with anger and danger. 

 Yellow: A cheerful and warm color, yellow is the most eye-catching of colures and is 

associated with optimism, self-esteem, extraversion, and friendliness. Yellow can 

conversely induce feelings of frustration and anger. 

4.2.2.Company logo 

Choosing the right logo colors can highlight your business‘ strengths and help you attract the 

right customers. And, as you might guess, the wrong combination can have the reverse 

effect.Everyone has heard of color psychology, which tells us that colors impact our 

emotions and behaviors. Yellow is cheerful (because the sun is bright and yellow!) and green is 

calming (like laying in the grass and looking up at a bunch of leaves is peaceful). 

 

https://99designs.com/blog/tips/how-color-impacts-emotions-and-behaviors/
https://99designs.com/blog/tips/how-color-impacts-emotions-and-behaviors/
https://99designs.com/blog/tips/how-color-impacts-emotions-and-behaviors/
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4.2.3. Consistent corporate image 

Corporate visual identity helps establish and maintain a company's corporate image, of which 

the color and design of a company's logo is central. This study examines the triadic relationship 

between color, design and the evoked meanings of logos to understand how these contribute 

to building a consistent corporate image. 

4.2.4. House styles 

Corporate house style is an essential component of branding a company in the minds of 

potential customers. Key elements of house style are colour, font and typography, logo and 

tone of language. Different colours have unique psychological effects on people. For example, 

orange is energetic and attention-grabbing, while blue evokes trust and stability. A corporation 

must pay considerable attention to the colours it uses in its internal and external 

communications. The logo is another key element of a firm's house style. 

4.2.5. Observing copyright legislation 

Copyright protection rules are fairly similar worldwide, due to several international copyright 

treaties, the most important of which is the Berne Convention. Under this treaty, all member 

countries and there are more than 100, including virtually all industrialized nations must afford 

copyright protection to authors who are nationals of any member country. This protection must 

last for at least the life of the author plus 50 years and must be automatic without the need for 

the author to take any legal steps to preserve the copyright 
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Self-Check -4 Written Test 

 

Direction I: Multiple choice item 

Instruction: Choose the best answer for the following questions and write the letter of your 

answer on the answer sheet provided in the next page. Use bold letter.(2 points 

each) 

1. What is organizational color? 

A. red                               C. warm color 

B. yellow                      D.All 

2. Which of the following is requirement in organization? 

A. company logo                       C. house style 

B. corporate image                    D. All 

 

 

 

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

Choose  

1____ 

2____ 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 points  

 

 

You can ask you teacher for the copy of the correct answers. 
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Information Sheet-5 Design document structure and layout 

 

5.1.Introduction to document structure and layout 

A document image is composed of a variety of physical entities or regions such as text blocks, 

lines, words, figures, tables, and background. We could also assign functional or logical labels 

such as sentences, titles, captions, author names, and addresses to some of these regions. 

The process of document structure and layout analysis tries to decompose a given document 

image into its component regions and understand their functional roles and relationships. The 

processing is carried out in multiple steps, such as pre- processing, page decomposition, 

structure understanding, etc. We will look into each of these steps in detail in the following 

sections. 

 

Document images are often generated from physical documents by digitization us- ing 

scanners or digital cameras. Many documents, such as newspapers, magazines and 

brochures, contain very complex layout due to the placement of figures, titles, and cap-tions, 

complex backgrounds, artistic text formatting, etc. A human reader uses a variety of additional 

cues such as context, conventions and information about language/script, along with a complex 

reasoning process to decipher the contents of a document. Automatic analysis of an arbitrary 

document with complex layout is an extremely difficult task and is beyond the capabilities of the 

state-of-the-art document structure and layout analysis systems. This is interesting since 

documents are designed to be effective and clear to human interpretation unlike natural image 

A document image is composed of a variety of physical entities or regions such as text blocks, 

lines, words, figures, tables, and background. We could also assign functional or logical labels 

such as sentences, titles, captions, author names, and addresses to some of these regions.  

 

The process of document structure and layout analysis tries to decompose a given document 

image into its component regions and understand their functional roles and relationships. The 

processing is carried out in multiple steps, such as pre- processing, page decomposition, 

structure understanding, etc. We will look into each of these steps in detail in the following 

sections. 

 

Document images are often generated from physical documents by digitization us- ing 

scanners or digital cameras. Many documents, such as newspapers, magazines and 

brochures, contain very complex layout due to the placement of figures, titles, and cap- tions, 

complex backgrounds, artistic text formatting, etc. .A human reader uses a variety of additional 
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cues such as context, conventions and information about language/script, along with a complex 

reasoning process to decipher the contents of a document. Automatic analysis of an arbitrary 

document with complex layout is an extremely difficult task and is beyond the capabilities of the 

state-of-the-art document structure and layout analysis systems.  

 

This is interesting since documents are designed to be effective and clear to human 

interpretation unlike natural image .A document image is composed of a variety of physical 

entities or regions such as text blocks, lines, words, figures, tables, and background. We could 

also assign functional or logical labels such as sentences, titles, captions, author names, and 

addresses to some of these regions. The process of document structure and layout analysis 

tries to decompose a given document image into its component regions and understand their 

functional roles and relationships. The processing is carried out in multiple steps, such as pre- 

processing, page decomposition, structure understanding, etc. We will look into each of these 

steps in detail in the following sections. 

 

5.2. Types of document structure and layout 

 Page border:-Microsoft Word gives you hundreds of page border options that 

allows you to surround a page with a clean or fancy border. 

 Boxes: - This opens a dropdown menu with a selection of predefined text box 

styles. There are a variety of styles and formatting to choose from, including text 

boxes with borders, shading, font colours and other attributes. Click one to insert 

it into your document. 

  Bullet or number lists:-This page should answer any of the questions you may 

have about creating different bulleted and numbered lists in Microsoft Word 

including any advanced lists. 

 Color:-This won‘t save custom colors. I believe to do that you must create your 

own color theme and save that as a default template for use every time. 

 Cropping:-Every image editing software has a crop tool that allows you to trim or 

eliminate the edges of an image. Cropping tools in Word allow you to hide 

portions of pictures that you do not want to be displayed in the final result. 

 Footnotes and cross-references:-Automates the numbering and placement of 

footnotes and enables you to easily cross-reference other sections of the 

document. 

 Endnotes:-An endnote is source citation that refers the readers to a specific 

place at the end of the paper where they can find out the source of the 
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information or words quoted or mentioned in the paper. When using endnotes, 

your quoted or paraphrased sentence. 

 Graphics:- Graphic design is also applied to layout and formatting of educational 

material to make the information more accessible and more readily 

understandable. Graphic design is applied in the entertainment industry in 

decoration, scenery, and visual story telling. 

 Headings:-it is process which incorporates the extruding and upsetting processes 

Headline, text at the top of a newspaper. 

  Layout: Allows you to specify different margins within a single document and to 

specify various methods for indenting paragraphs. 

 Headers, footers, and page numbering:-Allows you to specify customized 

headers and footers that the word processor will put at the top and bottom of 

every page.  

 Font size, style, and type: - This style decision must be applied consistently 

throughout the text. The font size of tables and figures can be smaller than the 

standard text if in accordance with the student‘s style guide and advisory 

committee. All document text with the exception of items embedded in figures 

must be black. Font size should be 11 or 12 point.Font size and font type must be 

consistent throughout the text.  

 Spacing: The document must be double spaced.Spacing around titles, headings, 

and subheadings should be consistent and match the student‘s chosen style 

guide. The only exceptions are: captions; foot-notes; long quotations; 

bibliographic references; table titles and descriptions; figure titles and 

descriptions; inserted materials such as tables, images, diagrams, graphs, etc.; 

and the author‘s curriculum vitae.  

 Extended direct quotations must be handled according to the rules of your chosen 

style guide and the direction of your advisory committee. Paragraphs should be 

indented the same number of spaces throughout the document, and spacing 

between paragraphs should be consistent. 
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Self-Check -5 Written Test 

Direction I: Multiple choice item 

Instruction: Choose the best answer for the following questions and write the letter of your 

answer on the answer sheet provided in the next page. Use bold letter.(2 points 

each) 

     1.  ___________is also applied to layout and formatting of educational material to make the 

information more accessible and more readily understandable 

A. Graphic design             C. Page layout  

B. Heeding                         D. Foot note 

2. Every image editing software has a crop tool that allows you to trim or eliminate the edges of 

an image. 

    A.  Cropping                           C. layout 

          B. Cross- reference                   D. indentation 

3. Corporate visual identity helps establish and maintain a company's corporate image, of 

which the color and design of a company's logo is central. 

         A. logo      C. Corporate name  

B. consistent corporate image   D.ALL 

 

 

 

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

Choose  

1____ 

2____ 

3____ 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 3 and above points           Unsatisfactory - below 3 points  

 

 

You can ask you teacher for the copy of the correct answers. 
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Operation sheet-1 Open Microsoft office word new document 

 

OPERATIONTITLE: Open Microsoft office word new document 

PURPOSE:  To open and create a document 

EQUIPMENT TOOLS AND MATERIALS:-Glove, desktop computer, mouse, monitor, 

keyboard. 

Step1: To start Word, choose Start → All Programs → Microsoft Office → Microsoft Office 

Word. 

        Step 2: Open Microsoft office word existing document 

Choose Office button → Open (Alt+F, O). In the Open window navigate to the folder and file 

you want to open. 

Step 3: Crate data 

          Start →all program →Microsoft office →Microsoft word →wright the document with keyboard. 

Step 4: Save data 

                  Start →all program →Microsoft office →Microsoft word →wright the document with keyboard 

→          File → save as → file location to save → desktop/document and save → click →ok  

Step 5:Open existing document 

                  Choose Office button → New (Alt+F, N) to open the New Document window. Then click ―New 

from existing…‖ (It sits directly below the ―Blank document‖ button). 

Precaution: use computer safety accessories 

Quality criteria:  Open and create document properly 
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Operation sheet 2 Create Header and footer 

OPERATIONTITLE: Create Header and footer 

PURPOSE:  To create Header and footer 

EQUIPMENT TOOLS AND MATERIALS:-Glove, desktop computer, mouse, monitor, 

keyboard. 

PROCEDURES:- 

Step1.Double-click the header or footer 

Step 2.Select Different Odd & Even Pages. 

 

Step 3.On one of the odd pages, select the header or footer area you want to change. 

Step4.Type the document title, and then press Tab twice. 

Step 5.Select Page Number > Current Position and choose a style. 

Step 6.Select an even page. 

Step 7.Select Page Number > Current Position and choose a style. 

Step 8.Press Tab twice and type the document title. 

Step 9.Select Close Header and Footer or press Esc to exit. 

 

Precaution: use computer safety accessories. 

Quality criteria:  create header and footer properly 
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Operation sheet 3 Arranging document style 

OPERATIONTITLE: Arranging document style 

PURPOSE:  To Arranging document style 

EQUIPMENT TOOLS AND MATERIALS:-Glove, desktop computer, mouse, monitor, 

keyboard. 

PROCEDURES:- 

Step 1. Modifying the Normal Style: Located at the lower, right-hand corner of the Style section 

(in the Home‘s tab) is a little diagonal arrow. To display the Styles menu, you must click on this 

arrow. You can also hit Alt+Ctrl+Shift+S. 

 

Step 2. In the Styles box, find Normal. Click the arrow (paragraph scroll) located to the right of 

the word (Do not click the word ‗Normal‘). 

 

Step 3. This will bring up a drop down menu. Select Modify. This will bring up menu called 

Modify Style. 

Precaution: use computer safety accessories 

Quality criteria:  arrange document style properly 
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Operation sheet 4 Insert a border 

OPERATIONTITLE: Insert border 

PURPOSE:  To Insert border 

EQUIPMENT TOOLS AND MATERIALS:-Glove, desktop computer, mouse, monitor, 

keyboard. 

PROCEDURES:- 

Step 1.Open Microsoft Word. 

Step 2.Click on the Page Layout tab. In Word 2013 and 2016, click on the Design tab instead. 

Step3.In the Page Background group, click the Page Borders option. 

Step4.In the Borders and Shading window (shown below), click the Page Border tab. 

Step 5.Select Box if you want a square border around your page. 

Step 6.Select the Style of border you want on the page, which can be solid, dotted, or dashed.  

Step 7.Select the Color and Width of the border. If you want to select artwork to use as the 

border, click the down arrow for the Art drop-down list. In the example below, we're using the 

hearts art as a border. 

 

Step 8.Once you've selected all the border options you want to use in your document, 

click the OK button to apply the border.\ 

Precaution: use computer safety accessories. 

Quality criteria: Insert border properly 
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LAP-Test Practical Demonstration 

 

Project Title: Using appropriate word-processing software 

Name:           ______________________                       Date:  ________________ 

Time started: _______________________          Time finished:  ___________ 

 

Instructions: Perform the following task properly within 3 hour. 

Task 1: Open Microsoft office word. 

Task 2. Create Header and footer 

Task 3. Arrange document style 

Task 4. Insert border 
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This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics –  

 Adjusting page layout to meet information requirements  

 Opening  and viewing different toolbars 

 Changing font format /font settings  

 Changing alignment and line spacing,  and modify margins of the document  

 Aligning information in a selected cell 

 Opening  and switching between several word documents 

 Using formatting features and styles to customize basic settings  

 Formatting cell or documents, creating table and adding images  

 Using technical functions, other data and formatting tools within the spreadsheet 

 Highlight and copy text from  different areas 

 Inserting headers and footers  

 Saving document in spreadsheet and close document and spreadsheet to a storage 

device 

This guide will also assist you to attain the learning outcome stated in the cover page. 

Specifically, upon completion of this Learning Guide, you will be able to – 

 Adjust page layout to meet information requirements  

 Open and view different toolbars 

 Change font format /font settings  

 Change alignment and line spacing,  and modify margins of the document  

 Align information in a selected cell 

 Open and switch between several word documents 

 Use formatting features and styles to customize basic settings  

 Format cell or documents, creating table and adding images  

 Use technical functions, other data and formatting tools within the spreadsheet 

 Highlight and copy text from  different areas 

 Insert headers and footers  

 Save document in spreadsheet and close document and spreadsheet to a storage device 

 

Instruction Sheet 
Learning Guide 39:  Customize basic settings and format 

documents to meet page layout conventions. 
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Learning Instructions:  

1. Read the specific objectives of this Learning Guide.  

2. Follow the instructions described below  

3. Read the information written in the ―Information Sheets 1- 6‖. Try to understand what are 

being discussed.  

4. Accomplish the ―Self-checks 1,2,3,4, 5 and 6‖ in each information sheets on pages 4, 

11,14,19,23 and 26. 

5. Ask from your teacher the key to correction (key answers) or you can request your teacher 

to correct your work. (You are to get the key answer only after you finished answering the 

Self-checks).  

6.If you earned a satisfactory evaluation proceed to ―Operation sheets 1, 2 and 3 on pages 

28,29 and 30.and do the LAP Test on page 31‖.  However, if your rating is unsatisfactory, see 

your teacher for further instructions or go back to Learning Activity.  

7. After you accomplish Operation sheets and LAP Tests, ensure you have a formative 

assessment and get a satisfactory result; then proceed to the next LG. 
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Information Sheet-1 Adjusting page layout to meet information requirements  

2.1. Adjust page layout to meet information requirements  

Allows you to specify different margins within a single document and to specify various 

methods for indenting paragraphs. The act or an instance of laying out. An arrangement or 

plan, especially the schematic arrangement of parts or areas: the layout of a factory; the layout 

of a printed circuit, Printing, The art or process of arranging printed or graphic matter on a 

page, The overall design of a page, spread, or book, including elements such as page and type 

size, typeface, and the arrangement of titles and page numbers, A page or set of pages marked 

to indicate this design, Sports The straight position. 

2.1.1. Page Orientation 

Page Layout and orientation of the page can be (Landscape or Portrait) is important to change 

document orientation of the page layout and the reverse. The default page orientation for 

Microsoft Word documents is portrait.  

2.1.2. Changing Paper Size 

The paper size in Microsoft Word documents can be set for the whole document and for 

individual sections of documents. 

 

2.1.3.Setting Paper Orientation  

Most business documents, school papers, and letters use a portrait page orientation, meaning 

the page is taller than it is wide. But sometimes you want a short, wide page landscape page 

orientation to accommodate a table, chart, or photo, or just for artistic effect. 

 

2.2. Layout for special needs 

2.2.1. Customizing paper size and source 

If you can‘t find the paper size you need on the Size menu, then you need to customize Your 

paper size, which you do in the Page Setup dialog box‘s Paper tab.  

 

2.2.2. Setting Document Margins 

Page margins are more than just empty space. The right page margins make your document 

more readable. Generous page margins make text look inviting and give reviewers room for 

notes and comments. With narrower margins, you can squeeze more words on the page; 

however, having too many words per line makes your document difficult to read.  
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Self-Check -1 Written Test 

Direction I: Multiple choice item 

Instruction: Choose the best answer for the following questions and write the letter of your 

answer on the answer sheet provided in the next page. Use bold letter. (2 points each) 

1. Which one of the following is page layout?  

A/ portrait and land scape                      C/ margin and view 

B/ page and size                                    D/ shape and margin  

2. ____________is a small fastener, now most commonly made of plastic, but also frequently 

made of metal, wood or seashell, which joins two pieces of fabric together 

A/Buttons                                C/ Buttons and Start menu 

B/Start menu                          D/ALL 

3. you use most often, programs that you want to display always when  you start clicked, you 

access all your programs and gives you links to some things that you use all the time, : 

A. The start menu                          C.Power Button 

B. Button                                       D.Key bored  

 

 

 

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

Choose  

1____ 

2____ 

3____ 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 3 and above points           Unsatisfactory - below 3 points  

 

 

You can ask you teacher for the copy of the correct answers. 

 

https://en.wikipedia.org/wiki/Fastener
https://en.wikipedia.org/wiki/Plastic
https://en.wikipedia.org/wiki/Seashell
https://en.wikipedia.org/wiki/Fabric
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Information Sheet-2 Opening  and viewing different toolbars 

2.1 .Opening and viewing different toolbars 

Next to the Start button Windows shows a range of buttons. These buttons access a range of 

different programs. To load the program, you would click on the button. It is called the Quick 

Launch toolbar. Below is a typical Quick Launch toolbar. 

2.1.1. Types of Tool bars 

Buttons  is a small fastener, now most commonly made of plastic, but also frequently made Of 

metal, wood or seashell, which joins two pieces of fabric together. In archaeology, a button 

Can be a significant artefact. In the applied arts and in craft, a button can be an example  

Of folk art, studio craft, or even a miniature work of art. 

2.2.2. Customising the Start menu 

The start menu shows the programs you use most often, programs that you want to display 

always When the Start button is clicked, lets you access all your programs and gives you links 

to some things that you use all the time, such as my computer and my documents. 

 

 

                                                          Figure-18: i=.tool bars 

 

https://en.wikipedia.org/wiki/Fastener
https://en.wikipedia.org/wiki/Seashell
https://en.wikipedia.org/wiki/Fabric
https://en.wikipedia.org/wiki/Archaeology
https://en.wikipedia.org/wiki/Artifact_(archaeology)
https://en.wikipedia.org/wiki/Applied_art
https://en.wikipedia.org/wiki/Crafts
https://en.wikipedia.org/wiki/Folk_art
https://en.wikipedia.org/wiki/Studio_craft
https://en.wikipedia.org/wiki/Art_object
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Self-Check -2 Written Test 

 

Direction I: Multiple choice item 

Instruction: Choose the best answer for the following questions and write the letter of your 

answer on the answer sheet provided in the next page. Use bold letter. (2 points each) 

1. Which one of the following is page layout?  

A/ portrait and land scape                 C/ margin and view 

B/ page and size                               D/ shape and margin  

2. ____________is a small fastener, now most commonly made of plastic, but also frequently 

made of metal, wood or seashell, which joins two pieces of fabric together 

A/Buttons                                    C/ Buttons and Start menu 

B/Start menu                                D/ALL 

3. You use most often, programs that you want to display always when you start clicked, you access  

all your programs and gives you links to some things that you use all the time, : 

A. The start menu                    C. Power Button 

B. Button                                   D. Key bored  

 

 

 

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

Choose  

1____ 

2____ 

3____ 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 3 and above points           Unsatisfactory - below 3 points  

 

 

You can ask you teacher for the copy of the correct answers. 

 

https://en.wikipedia.org/wiki/Fastener
https://en.wikipedia.org/wiki/Plastic
https://en.wikipedia.org/wiki/Seashell
https://en.wikipedia.org/wiki/Fabric
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Information Sheet-3 Changing  font format /font settings 

 

3.1.Introduction to font format  

Format Requirements for Font Size, Style, and Type and Spacing 

Combination of typeface and other attributes :( Pitch, Size and Spacing character symbol)the 

font must be a standard style that is clear and readable. Script, cursive, and pictorial fonts are 

prohibited.All document text with the exception of items embedded in figures must be black. 

Font size should be 11 or 12 point. 

Font format is formatting document and spread sheet with formatting tools such as: 

 Insert a shape. On the Format tab, in the Insert Shapes group, click a shape, and then 

click somewhere in the document. 

 Change a shape. Click the shape you want to change. On the Format tab, in the Insert 

Shapes group, click Edit Shape, point to Change Shape, and then choose a different 

shape. 

 Add text to a shape. Click the shape you where you want text, and then type. 

 Group selected shapes. Select several shapes at a time by pressing CTRL on your 

keyboard and clicking each shape you want to include in the group. 

 Adjust the size of the shapes. Select the shape or shapes you want to resize.  

 Apply a style to a shape. In the Shape Styles group, rest your pointer over a style to se 

What your shape will look like when you apply that style.  

 Click the style to apply it. Or, click Shape Fill or Shape Outline and select the options  

That you want.  

 

Figure -19: Font shape styles 
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 Add flow charts with connectors. Before you create a flow chart, add a drawing canvas 

by clicking the Insert tab, clicking Shapes in the Illustrations group, and then 

clicking New Drawing Canvas.  

 

 On the Format tab, in the Insert Shapes group, click a Flow chart shape. Under Lines, 

choose a connector line such as the Curved Arrow Connector. 

 Align the objects on the canvas. To align the objects, press and hold CTRL while you 

select the objects that you want to align. On the Format tab, in the Arrange group, 

click Align to choose from an assortment of alignment commands. 

 

Figure -20: Font size 

3.2. Change the document theme or theme colour 

If you used a color under theme Colors to apply shading in your document, you can change the 

color of the shading and other colors in your document by applying a new theme or theme color 

to the document. 
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Self-Check -3 Written Test 

 

Direction I: Multiple choice items 

Instruction: Choose the best answer for the following questions and write the letter of your 

answer on the answer sheet provided in the next page. Use bold letter. (2 points each) 

1. Which is true about Font formatting? 

A. Insert a shape                           C. Add text to a shape 

B. Change a shape                      . D. Group selected shapes 

2. ____________is to apply shading in your document, you can change the color of the shading 

and other colors in your document by applying a new theme or theme color to the 

document. 

A. Theme Colors               .C. drawing  

B. Painting                   D. Word art  

3. To align the objects, press and hold CTRL while you select the objects that you want to align. 

A. Drawing                                            C. Painting    

B. Align the objects on the canva          D. Word art  

 

Note: Satisfactory rating – 3 and above points           Unsatisfactory - below 3 points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

Choose  

1____ 

2____ 

3.____ 

 

 

 

Score = ___________ 

Rating: ____________ 
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Information Sheet-4 Changing alignment and line spacing,  and modify margins  

 

4.1. Introduction to alignment and line spacing 

Alignment:-To change the horizontal placement of text, in the Alignment box, 

choose Left, Center, Right, justified, or Distributed. Justified spacing between words so that the 

lines of text touch both the left and right margins, except for the last line of the paragraph, 

which uses normal word spacing. 

 

 Distributed is similar to Justified, but even the last line touches both the left and right margins, 

with space added between words and letters, as necessary.Line spacing (single-space, double-

space, and so on) and vertical alignment (top, bottom, or middle) are available from menu 

buttons on the Home tab of the Ribbon, in the Paragraph group. 

 

Spacing:-To change the spacing above or below a paragraph, type or click the arrows next 

to before or after. This number can be any whole number or a decimal, such as 6.5.To change 

the spacing above and within a paragraph, use the Line Spacing options: Single, 1.5 Lines, 

or Double.  

 

Note: If you keep adding lines until you run out of room in a placeholder, AutoFit adjusts line 

spacing and font size to fit all list items in the placeholder. When this happens, the AutoFit 

Options control appears. To turn off AutoFit, click AutoFit Options, and then click Stop Fitting 

Text to This Placeholder. 

4.2. Types Alignment 

Centred is to centre your content on the page alignment gives documents a formal appearance 

and is often used for cover pages, quotes, and something Justified distribute your text evenly 

between the margins. Justified text gives your document clean, crisp edges so it looks more 

polished. Left Align your content with the left margin. Right Align your content with the right margin. 

 

4.3.Page Setup and Margin Formatting   

The screenshot below displays the menu path to change the margins in a paper. According to 

APA, all margins are set at 1 inch. 
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Figure -21: Page set up and margin formatting 
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Self-Check -4 Written Test 

Direction I: Multiple choice items 

Instruction: Choose the best answer for the following questions and write the letter of your 

answer on the answer sheet provided in the next page. Use bold letter. (2 points each). 

 

1. To add indentation or change the amount of indentation before text, select or type a 

number in the before text box.  

A. Indentation                           C. Spacing 

B. Line spacing                         D. Alignment 

2. ____________is to centre your content on the page alignment gives documents a formal 

appearance and is often used for cover pages, quotes, and something? 

A. Centred                                      C. Left  

B. Justified                                      D.Right. 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

Choose  

1____ 

2____ 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Information Sheet-5 Aligning information in a selected cell 

5.1. Introduction to aligning information  

Alignment: To change the horizontal placement of text, in the Alignment box, 

choose Left, Center, Right, Justified, or Distributed. Justified add spacing between words so 

that the lines of text touch both the left and right margins, except for the last line of the 

paragraph, which uses normal word spacing. Distributed is similar to Justified, but even the 

last line touches both the left and right margins, with space added between words and 

letters, as necessary. 

Horizontal Alignment − you can set horizontal alignment to Left, Centre, Right, etc. 

 Left − Aligns the cell contents to the left side of the cell. 

 Center − Centers the cell contents in the cell. 

 Right − Aligns the cell contents to the right side of the cell. 

 Fill − Repeats the contents of the cell until the cell‘s width is filled. 

 Justify − Justifies the text to the left and right of the cell. This option is applicable only 

if the cell is formatted as wrapped text and uses more than one line. 

Vertical Alignment − you can set Vertical alignment to top, Middle, bottom, etc. 

 Top Aligns the cell contents to the top of the cell. 

 Center Centers the cell contents vertically in the cell. 

 Bottom Aligns the cell contents to the bottom of the cell. 

 Justify Justifies the text vertically in the cell; this option is applicable only if the cell is 

formatted as wrapped text and uses more than one line. 
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Direction I: Multiple choice items 

Instruction: Choose the best answer for the following questions and write the letter of your 

answer on the answer sheet provided in the next page. Use bold letter. (2 points each). 

1. Which one of the following is important for Vertical Alignment? 

A Top C. Bottom  

B. RightD. Justify  

2. ____________isrepeats the contents of the cell until the cell‘s width is filled 

A. Left C. Right 

B. Center D. Fill  

3. A tool used to check the quality of constructed or installed works is: 

A. Fill   C. Center 

B. Drawings             D. Alignment Tab 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

Choose  

1____ 

2____ 

3.____ 

 

 

 

 

 

 

Self-Check -5 Written Test 

Score = ___________ 

Rating: ____________ 
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Information Sheet-6 Opening  and switching between several word documents 

6.1. Opening word document. 

Creating and Opening Documents There are several ways to create new documents, open 

existing documents, and save documents in Word:  

Create a New Document 

New Document button on the menu bar. Choose File New from the menu bar.  

Press CTRL+N (depress the CTRL key while pressing "N") on the keyboard.   

Open an Existing Document  

 Open File button on the menu bar. Choose File| Open from the menu bar.  Press CTRL+O 

on the keyboard.  Each method will show the Open dialog box. Choose the file and click the 

Open button.   

 

Figure -22:.Openeing document 

Open Documents  

To rename a Word document while using the program, select File/ Open and find the file you 

want to rename. Right-click on the document name with the mouse and select Rename from 

the shortcut menu. Type the new name for the file and press the ENTER key. 
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Figure -23: Rename a file 

 

  

Close a Document:-Close the current document by selecting File| Close or click the Close 

icon if it's visible on the Standard Toolbar.    
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Self-Check -6 True/False 

 

Direction I: True/False 

Instruction: Say True for correct statement and False for wrong statement. (2 points 

each). 

1. When you open a document you click on format. 

2. To save a document you click on insert tool. 

 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2____ 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Information Sheet-7 
Using formatting features and styles to customize basic 

settings. 

 

7.1. Introduction to formatting features  

 

 Types of formatting features 

 

 Bold is making your text bold   

 Italics is italicize the text 

 Underline to underline the text 

 

 

 

Figure -22:Formating Features 

 

7.3. Format cell or documents, create table and add images 

7.3.1.Formatting Tables 

A table is a grid of cells arranged in rows and columns. Tables can be customized and are 

useful for various tasks such as presenting text information and numerical data. In this 

lesson, you will learn how to convert text to a table, apply table styles, format tables, and 

create blank tables. 

Bold, underline 
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Direction I: Multiple choice items 

Instruction: Choose the best answer for the following questions and write the letter of your 

answer on the answer sheet provided in the next page. Use bold letter. (2 points each). 

1. Which one of the following is formatting features? 

A .bold                           C. underline 

B. italic                           D. ALL 

2.__________ is a grid of cells arranged in rows and columns. 

A .graph                                    C. table 

B. chart                                      D. row 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

Choose 

1____ 

2_____ 

 

 

 

 

Self-Check -7 Written Test 

Score = ___________ 

Rating: ____________ 
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Information Sheet-8 
Use technical functions, other data and formatting tools to 

complete document. 

8.1. Formatting Tools 

Toolbars Many toolbars displaying shortcut buttons are also available to make editing and 

formatting quicker and easier. Select View Toolbars from the menu bar to select the toolbars. 

The toolbars that are already displayed on the screen are checked. Add a toolbar simply by 

clicking on the name. 

The Formatting tab in the TXLF Editor includes formatting tools that can be used to edit the 

target content format. 

As with most Microsoft Word features, this command too factors special formatting needs 

and can be used to replace a text with its format across a document. For instance, you can 

use this feature to consistently replace the word ‗bold‘ with ‗bold‘ all through the document. 

The formatting toolbar is the easiest way to change many attributes of text. If the toolbar as 

shown below isn't displayed on the screen, select View Toolbars and choose 

 

 

Style Menu - Styles are explained in detail later in this tutorial.  ƒ Font Face - Click the 

arrowhead to the right of the font name box to view the list of fonts available. Scroll down to 

the font you want and select it by clicking on the name once with the mouse. A serif font (one 

with "feet" circled in the illustration below) is recommended for paragraphs of text that will be 

printed on paper as they are most readable. 

- Click on the white part of the font size box to enter a value for the font size or click the 

arrowhead to the right of the box to view a list of font sizes available. Select a size by clicking 

on it once. A font size of 10 or 12 is best for paragraphs of text. ƒ Font Style - Use these 

buttons to bold, italicize, and underline text. ƒ Alignment - Text can be aligned to the left, 

center, or right side of the page or it can be justified across the page.  ƒ Numbered and 

Bulleted Lists - Lists are explained in detail later in this tutorial.  ƒ Increase/Decrease Indent - 

Change the indentation of a paragraph in relation to the side of the page. ƒ Outside Border - 
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Add a border around a text selection. ƒ Highlight Color - Use this option to change the color 

behind a text selection. The color shown on the button is the last color used. To select a 

different color, click the arrowhead next to the image on the button. ƒ Text Color - This option 

changes the color of the text. The color shown on the button is the last color chosen. Click 

the arrowhead next to the button image to select another color. 

 

Figure -23: Tool bars 

 

 

8.2. Formatting functions 

If you haven‘t guessed already, the most loved aspect of Word is the wide variety of 

formatting features it provides. We‘ve explored just a few. But to uncover all the gems 

available, you need to become intimately familiar with the Home Tab View. 

 



                                                            

Page 51 of 226 
 

Federal TVET Agency 
Author/Copyright  

Irrigation and drainage construction 
Level -II 

Version -2 

September 2019 

 

 

Figure -24: Formatting tables 

 

The Home tab contains 5 command groups for better formatting: Clipboard, Font, Paragraph, 

Styles and Editing. 

Clipboard: This contains the cut-copy-paste commands explained above. 

Paragraph: This contains commands to control the alignment and spacing between 

lines in a paragraph. Special commands include the Shading command (Alt + H) and 

the Border command (Alt + B) that allow you to color text cells and border them (as if 

they were in a table), respectively 

Styles: This is explained in detail below. 

Editing: This group captures the standard find-replace features explained above. 

And this brings us to Word‘s most popular command group: Font! 

Font: This is the group you will use most to format your text. 

The font menu is your one-stop point for exploring all available font-editing features in 

Microsoft Word. You can invoke it by a right-click and choose the ―Font…‖ option, or use the 

keyboard shortcut (Control + D). And it looks like this: 

 

 

 

 

8.3. Open type features 

 

Use this to edit the ligature of your font. (This determines how characters look when 

combined together.) For instance, here‘s what happens to the numeric characters with 

Georgia font, when you set the ―number forms‖ feature to ―lining‖: they get neatly aligned. 

8.4. Word styles 

 

Word uses Styles to create a pre-defined ―way‖ of (consistently) formatting font and 

paragraphs, across a single Word document. Take a moment now to look at the Styles 

command group on the Home Tab. It looks a bit like this: 
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Figure -25: Formatting styles 

8.5. Technical functions 

 animations 

 arranging slides 

 charts 

 customising masters 

 illustrations 

 linking content 

 sharing 

 SmartArt 
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Self-Check -8 Written Test 

 

Direction I: Multiple choice items 

Instruction: Choose the best answer for the following questions and write the letter of your 

answer on the answer sheet provided in the next page. Use bold letter. (2 points each). 

1. Which one of the following is technical function? 

     A. animations                           C.charts 

          B.illustrations                         D. all 

 

    2._________ contains commands to control the alignment and spacing between lines. 

    A. paragraph                  C.charts 

          B.illustrations                D. all 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

Choose 

1____ 

2_____ 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Information Sheet-9 Highlight and copy text from  different areas 

9.1. Highlight and copy text  

Right-click the selected text and select Copy. Click Edit from the top File menu in the program  

And then click Copy. Highlight the text and use the shortcut key Ctrl+C or Ctrl+Insert on  

A PC or Cmd+C on an Apple Mac. You must highlight or select something before it can be copied. 

Copying Text  To copy text, choose Edit|Copy, click the Copy button on the standard toolbar, or press 

CTRL+C to copy the text to the clipboard. Paste Text To paste cut or copied text, move the cursor  

to the location you want to move the text to and select Edit|Paste from the menu bar, click the Paste 

button on the standard toolbar, or press CTRL+V.   

9.2. Highlighting  

Under normal circumstances, screen readers do not convey any information about highlighting to blind 

users.  Here are a couple of ideas of ways to draw attention to text in Word for blind users: • Write the 

word "important" (or similar): The most reliable way in Word to "highlight" text for blind users is to write 

some text in the document that draws attention to the content. You could put the word "Important" (or 

"Warning" or "Attention," etc.) before the important content, for example.  

 

Figure -26:.Highliting 

9.3. Hidden text 

If you don't want to add any visual words to the document, you could add some hidden text just for 

screen reader users. In HTML, and there are multiple techniques (add the text via aria-label, hide the 

text with the CSS clipping technique, hide the text off-screen, etc.). Though there are not as many 

techniques in Word, it is possible to hide content. 
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Self-Check -9 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. Under normal circumstances, screen readers do not convey any information about 

highlighting to blind users. 

2. If you don't want to add any visual words to the document, you could add some 

hidden text just for screen reader users. 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Information Sheet-10 Insert headers and footers 

10.1 Insert header and footer 

It can make your document look professional and polished by utilizing the header and footer 

sections. The header is a section of the document that appears in the top margin, while 

the footer is a section of the document that appears in the bottom margin. Headers and 

footers generally contain information such as the page number, date, and document name. 

In this lesson, you will learn how to insert and edit headers and footers. 

 

Headers and footers can help keep longer documents organized and make them easier to 

read. Text entered in the header or footer will appear on each page of the 

document.Headers are help you to repeat content at the top of every page. They are useful 

for show casing information, like title, author, and page number.Footers are help you to 

repeat content at the bottom of every page. 

 

 

 

Figure -27: Header & Footer 
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Self-Check -10 True/False 

 

Direction I:True/False 

Instruction: Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. The header is a section of the document that appears in the top margin 

   2.Headers and footers can help keep longer documents organized and make them easier to 

read. 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Information Sheet-11 Save document in another file format  

 

11.1. Introduction of Saving Document: 

It is the Microsoft Way to give you multiple ways to save document /spared sheet. Whether 

that‘s because the company‘s programmers believe in giving you lots of choices, or because 

they can‘t make up their minds about the best way to do something is a question best left to 

the philosophers. But the point is, you do have a choice. You don‘t have to memorize every 

keystroke, button, and command. Especially with saving, the important thing is to find a way 

you like and stick with it, so file can be saved different file formats such as: CSV files, doc 

files, HTML pages, PDF files, SXW (star office) files, RTF files, text files. 

 

Figure -28:.Save document 

 

11.2 Type of File format  

 CSV files 

 doc files 

 HTML pages 

 PDF files 

 SXW (star office) files 

 RTF files 

 Text files. 
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Self-Check -11 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. CSV files a type of file format 

2. You don‘t have to memorize every keystroke, button, and command 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2____ 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Information Sheet-12 
close document and spreadsheet to a storage 

device 

12.1. Close document 

12.2. Types of storage device 

DiskCompact Disk (CD), Digital Versatile Disk (DVD), and magnetic tape. Commonly used 

secondary storage devices can be grouped as magnetic or optical. Magnetic devices use 

magnetic technology to write and read data from the storage surface. This category includes 

hard disk, floppy disk, and magnetic tape. On the other hand, optical storage devices use 

laser technology. CD and DVD fall under this second category. 

 

12.2.1.CD(Compact Disc) 

CD-ROM, CD-R, and CD-RW: CD-ROM (Compact Disc – Read Only Memory): is a version 

of the CD that allows the information to be stored so that the user can only read from the 

disks. Once data is recorded on a CD-ROM, new data cannot be stored and the disc cannot 

be erased. Although CD-ROMs look like music discs, they can only be used with a 

computer equipped with a CD-ROM drive. 

12.2.2.CD-R (Compact Disc 

CD-R (Compact Disc - Recordable): refers to compact disks that can be recorded only 

once, but read many times. If the recorded content is no longer wanted, additional material 

can be recorded only on the remaining space on the disk. The disks themselves are 

constructed differently from ordinary CDs. 

 

CD-RW (Compact Disc - Rewritable): Is an extension of CD-R whereby you can rewrite data 

or audio to the same CD many times? Not all CD drives can read CDRWs. 

DVD)Digital Versatile Disc  

 

DVD is an optical disc storage media that can be used for storing data, including movies 

with high video and sound quality. DVDs resemble CD: their physical dimensions are the 

same – 12 cm or the mini 8cm - but they are encoded in a different format. This enables 

DVDs to store more data than that of CDs. A typical DVD can often hold more data than 6 

CDs. DVDs can store an entire movies. 
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11.4.Common Types of DVDs 

DVD-ROM: These DVDs are read-only disks. They are accessed using a special DVD drive 

attached to a personal computer. They are often used for movies (which are more 

specifically referred to as DVD-Video) and computer games. 

DVD-R: It offers a write-once, read-many time‘s storage format similar to CDR, but can hold 

more information than a CD-R. 

11.4.1.DVD-RW: A recordable DVD format similar to CD-RW. 

 

External hard drive, including universal serial bus (USB) flash drive: 

A hard disk contains both the disk and the drive (the slot) that is used to read and write data 

on the disk. A hard disk uses rigid turning disks to store data and programs. They have 

read/write heads which can read data from the hard disk and write data to the hard disk.  

Internal Hard Disk:A hard disk contains both the disk and the drive (the slot) that is used to 

read and write data on the disk. A hard disk uses rigid turning disks to store data and 

programs. They have read/write heads which can read data from the hard disk and write 

data to the hard disk. The hard disk drive is sealed. 

This protects the hard disk drive internals from dust, condensation, and other sources of 

contamination. Hard disks can store much more data than floppy disks, and access and 

transmit it faster. Currently an average hard disk can store 60 to 80 GB of data. 

web storage 

Can store much more data than  other types of storage such as floppy disks, hard disk and 

also safe for mechanical as well as vires attack of data and stored for long time example of 

web storage is email, internet. 
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Self-Check -12 Written Test 

 

Direction I: Multiple choice items 

Instruction: Choose the best answer for the following questions and write the letter of your 

answer on the answer sheet provided in the next page. Use bold letter. (2 points each). 

 

1. Which of the following is a type of storage devices? 

A. DVD-RW                   C.DVD-ROM 

B. DVD-RD.ALL 

2. Digital Versatile Disk is_______________. 

A.DVD-RW                   C.DVD-ROM 

B.DVD-R    D.ALL 

 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

Choose 

1____ 

2_____ 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Operation sheet 1  Page Layout 

OPERATIONTITLE:Page layout 

PURPOSE:  To lay the page 

EQUIPMENT TOOLS AND MATERIALS:-Glove, desktop computer, mouse, monitor, 

keyboard. 

PROCEDURES:- 

Step 1.On the Layout tab (PAGE LAYOUT in previous versions of Word), in the Page Setup 

group, click 

 

Click Landscape  

Step2: select the paper size of your choice 
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Operation sheet 2  Change the paper size for  document 

 

OPERATIONTITLE:Change the paper size for document 

PURPOSE:  TO Change the paper size for document 

EQUIPMENT TOOLS AND MATERIALS:-Glove, desktop computer, mouse, monitor, 

keyboard. 

PROCEDURES:- 

Step 1.On the Layout tab, in the Page Setup group, click Size 

 

Step 2.Select More Paper Sizes: 

Step 3.In the Page Setup dialog box, choose a paper size and for Apply to, select Whole 

document:  

 

Step4 .Click OK. 

Precaution: use computer safety accessories. 

Quality criteria:change paper size accurately  
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Operation sheet 3  Format Font Size 

 

OPERATIONTITLE: Format font size 

PURPOSE:  TO format font size 

EQUIPMENT TOOLS AND MATERIALS:-Glove, desktop computer, mouse, monitor, 

keyboard. 

PROCEDURES: 

Step 1.Left-click the drop-down arrow next to the font size box on the Home tab. 

The font size drop-down menu appears. 

Step 2.Move your cursor over the various font sizes. A live preview of the font size 

will appear in the document.  

Step 3.Left-click the font size you wish to use. The font size will change in the 

document. 

 

 

Precaution: use computer safety accessories. 

Quality criteria: create font size accurately  
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OPERATIONTITLE: Format font style  

PURPOSE:  TO format font style 

EQUIPMENT TOOLS AND MATERIALS:-Glove, desktop computer, mouse, monitor, 

keyboard. 

PROCEDURES: 

Step 1.Select the text you wish to modify. 

Step 2.Left-click the drop-down arrow next to the font style box on the Home tab. 

The font style drop-down menu appears. 

Step 3.Move your cursor over the various font styles. A live preview of the font will 

appear in the document. 

 

Step4.Left-click the font style you wish to use.  

Precaution: use computer safety accessories. 

Quality criteria: create font style accurately  

 

 

 

Operation sheet 4 Format Font Style 
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OPE

RATIONTITLE:Format font color 

PURPOSE:  TO format font color 

EQUIPMENT TOOLS AND MATERIALS:-Glove, desktop computer, mouse, monitor, 

keyboard. 

PROCEDURES: 

Step 1.Select the text you wish to modify. 

Step 2.Left-click the drop-down arrow next to the font color box on the Home tab. 

The font color menu appears. 

Step3.Move your cursor over the various font colors. A live preview of the color will 

appear in the document. 

Step 4.Left-click the font color you wish to use.  

Step 5.click OK. 

Precaution: use computer safety accessories. 

Quality criteria: create font color accurately  

 

 

 

 

 

 

 

 

 

Operation sheet 4 Format Font colour 
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LAP-Test Practical Demonstration 

 

Project Title:Customize basic settings and format documents to meet page layout 

conventions 

Name:           ______________________                       Date:  ________________ 

Timestarted: _______________________ Timefinished:  ___________ 

Instructions: Perform the following task properly within 2 hour. 

Task 1:Create Page layout 

Task 2: Format font size 

Task 3.Format font style 

            Task 4. Format font color 
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Instruction sheet 
Learning Guide 40:  Create tables and add images to 

word document 

 

This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics –  

 Inserting standard table into document 

 Changing cells (insert and delete columns and rows)  

 Inserting  appropriate images into document and customize  

 Positioning and resizing images to meet document  

 Naming and storing/ saving documents in appropriate directories or folders  

 Printing documents  

This guide will also assist you to attain the learning outcome stated in the cover page. 

Specifically, upon completion of this Learning Guide, you will be able to – 

 Insert standard table into document 

 Chang cells (insert and delete columns and rows)  

 Insert appropriate images into document  

 Position and resize images to meet document 

 Name and store/ savedocuments in appropriate directories or folders  

 Print documents  

 

Learning Instructions:  

1. Read the specific objectives of this Learning Guide.  

2. Follow the instructions described below  

3. Read the information written in the ―Information Sheets 1- 6‖. Try to understand what 

are being discussed.  

4. Accomplish the ―Self-checks1, 2, 3, 4, 5 and 6‖ in each information sheets on pages 4, 

11,14,19,23 and 26. 

5. Ask from your teacher the key to correction (key answers) or you can request your 

teacher to correct your work. (You are to get the key answer only after you finished 

answering the Self-checks).  

6. 6.If you earned a satisfactory evaluation proceed to ―Operation sheets 1, 2 and 3 on 

pages 28,29 and 30.and do the LAP Test on page 31‖.  However, if your rating is 

unsatisfactory, see your teacher for further instructions or go back to Learning Activity.  
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7. After you accomplish Operation sheets and LAP Tests, ensure you have a formative 

assessment and get a satisfactory result; then proceed to the next LG. 
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InformationSheet1    Insert standard table into document 

 

1.1. Standard table 

A table is an arrangement of information in rows and columns containing cells that make 

comparing and contrasting information easier 

A table is a grid of rows and columns that intersect to form cells. It's often easier to read or 

present information in table format than in paragraph format. Using word's table feature, you 

can create a table and insert text, pictures, or another table into the table's cells.  

Microsoft Word tables are a versatile tool that can help you present information in an 

organized way. Tables are easy to insert and modify. A couple of clicks enable you to create 

a simple table.Use MS Word tables to place information into rows and columns. 

Alternatively, you can use tables as a way to position images that would otherwise be hard 

to place in the overall layout of a document.  

Word tables are the perfect easy way to display complex visual information in a page easily. 

You can also use tables in templates to simplify a complex layout. Table styles in 

Microsoft Word allow you to change the format of a table at any time and still maintain a 

cohesive, professional-looking document. A table style provides a consistent look to borders, 

shading, alignment, and fonts in tables. 

The insert command is used for inserting one or more rows into a database table with 

specified table column values. 

 

1.2. How to Make a Table on Microsoft Word 

 

Tables help you present information in a clear and organized way. There are three ways to 

add tables to your documents in Microsoft Word, each taking only a few easy steps. These 

instructions are based on Microsoft Word 2003, but the process is very similar in other 

versions of Word. 

 

 

 

 

 

Here's how to make a table from the tables and borders toolbar: 

 Place the cursor where you want to place the table. 

https://www.computerhope.com/jargon/r/row.htm
https://www.computerhope.com/jargon/c/column.htm
https://www.computerhope.com/jargon/c/cell.htm
https://www.lifewire.com/microsoft-word-4159373
https://computer.howstuffworks.com/microsoft.htm


                                                            

Page 72 of 226 
 

Federal TVET Agency 
Author/Copyright  

Irrigation and drainage construction 
Level -II 

Version -2 

September 2019 

 

 Click the Insert Table icon on the Tables and Borders toolbar at the top of the window.  

 Drag the corner of the table until you have the desired number of columns and rows. 

 Click the mouse to insert the table. 

1.2. Inserting standard tables 

A good table in your document can help make your data stand out to your readers, and 

adding a table in word is a snap. You have a variety of options for customizing your table‘s 

look at functionality, and you can even choose from existing templates to make inserting 

tables completely painless.  

 

 

 

Figure -29.Inserting a table. 
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Self-Check -1 True/False 

 

Direction I:True/False 

Instruction: Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. A table is an arrangement of information in rows and columns containing cells.  

2. Word tables are the perfect easy way to display complex visual information in a page 

easily. 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

https://www.computerhope.com/jargon/r/row.htm
https://www.computerhope.com/jargon/c/column.htm
https://www.computerhope.com/jargon/c/cell.htm
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InformationSheet2             Change cells to meet information requirements 

2.1. Cells 

A table is made up of rows and columns. The intersection of a row and column is called a 

cell. Tables are often used to organize and present information, but they have a variety of 

other uses as well. 

2.2. Insert and delete columns and rows  

Columns and rows 

A table is a structure of vertical columns and horizontal rows with a cell at every intersection. 

A Word table can contain as many as 63 columns but the number of rows is unlimited. 

 On a display screen in character mode, a column is a vertical line of characters 

extending from the top to the bottom of the screen. The size of a text display is usually 

measured in rows and columns.  

 In spreadsheets, a column is a vertical row of cells. Spreadsheet columns are usually 

identified by letters. 

A row is identified by the number that is on left side of the row, from where the row 

originates.  

Columns run vertically downward across the worksheet and ranges from A to XFD - 1 to 

16384. A column is identified by a column header that is on the top of the column, from 

where the column originates. 

2.3.Add a row or column 

 In your table to add a row or column and then click the Layout tab (this is the tab next to the 

Table Design tab on the ribbon). 

 

Figure -30..Delete table 
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Self-Check -2 True/False 

 

Direction I: True/False 

Instruction: Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. A table is a structure of vertical columns and horizontal rows with a cell at every 

intersection 

2. A row is identified by the number that is on left side of the row, from where the row 

originates.  

3. Tables are often used to organize and present information. 

 

Note: Satisfactory rating – 3 and above points         Unsatisfactory - below 3 points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

3_____ 

 

Score = ___________ 

Rating: ____________ 
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Information Sheet 3          Insert  and customize images into document 

 

3.1. Clip art 

Clip art refers to a graphic or a picture that you can insert in your document. It comes in 

different formats and styles. It is used to enhance the appearance of a document.  

Clip art refers to a graphic or a picture that you can insert in your document. It comes in 

different formats and styles. It is used to enhance the appearance of a document. 

 

Figure -31.Clip Art 

3.2. Graphics 

The term also refers to the images themselves. For example, certain word processors 

support graphics because they let you draw or import pictures. 

A graphics monitor is a display monitor that can display pictures. A graphics 

board (or graphics card) is a printed circuit board that, when installed in a computer, permits 

the computer to display pictures. 

 

3.3. Pictures 

Word allows you to insert pictures into your document such as logos of 

companies, photos and other pictures to give more interest or a more professional speed 

(look) to your document.  

 

Figure -32.Autoshape 

 

https://www.webopedia.com/TERM/G/graphics_monitor.html
https://www.webopedia.com/TERM/M/monitor.html
https://www.webopedia.com/TERM/P/printed_circuit_board.html
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Figure -32.Insert picture 
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Self-Check -3 True/False 

 

Direction I:True/False 

Instruction: Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. Clip art refers to a graphic or a picture that you can insert in your document 

2. A graphics monitor is a display monitor that can display pictures 

 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

https://www.webopedia.com/TERM/G/graphics_monitor.html
https://www.webopedia.com/TERM/M/monitor.html
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Information Sheet 4                  Customizing images 

 

4.1. Position and resize images to meet document formatting needs 

Positioning a picture and other objects (Shape, SmartArt, Icons, 3D Models, 

etc.) means placing them in the exact position in the document wherever you 

want. Whether it is on the top left, top center, top right, middle left,  middle 

center, and middle right, bottom left, bottom center, or bottom right. When you 

position an object, the text wraps around it. Follow the steps below on positioning 

a Picture and other Objects in MS-Word. 

4.1.1. Document formatting 

How to Edit a Picture's Size in Word 

Ideally, you should format your picture in a  photo editing program, but you can 

also use Microsoft Word to do some simple editing. To resize a photo in Word, 

click it once and then drag a corner box in or out to make the picture smaller or 

larger. 

Word provides a variety of options for changing the layout of your pictures. For 

example, you can have the text wrap around the photo or you can insert the 

picture in line with the document text.  

 

4.1.2. Positioning and resizing image 

If you want to use Word to edit photos, or if you frequently include images in 

your Word document, you should familiarize yourself with the compression 

options. Compressing Word photos will help you limit the file  size of 

documents that contain images. 

 

 

 

 

 

 

https://digiruns.com/wrap-text-around-an-object/
https://www.lifewire.com/free-photo-editors-1357098
https://www.lifewire.com/resize-image-and-objects-3540363
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Self-Check -4 True/False 

 

Direction I:True/False 

Instruction: Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. Positioning a picture and other objects (Shape, Smart  Art, Icons, 3D 

Models, etc.) means placing them in the exact position.  

2. Ideally, you should format your picture in a photo editing program, but you 

can also use Microsoft Word to do some simple editing.  

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

https://www.lifewire.com/free-photo-editors-1357098
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Information Sheet 5                 Naming and saving of documents in appropriate 

directories or folders 

 

5.1. Directories and folders 

A directory is defined as an organizational unit, or container, used to organize folders and 

files into a hierarchical structure. You can think of a directory as a file cabinet that 

contains folders that contain files. 

The main difference is that a folder is a logical concept that does not necessarily map to a 

physical directory. A directory is a file system object. A folder is a GUI object. The 

term directory refers to the way a structured list of document files and folders is stored on the 

computer. A file is a collection of data that is stored on disk and that can be manipulated as a 

single unit by its name. A directory is a file that acts as a folder for other files. 

5.2. Naming files and folders 

Naming conventions are rules which enable the titling of electronic and physical folders, 

documents and records in a consistent and logical way. This ensures that the correct records 

can be located, identified and retrieved from a filing system in a timely fashion, and that they 

are stored in an appropriate secure location. Ideally, the best time to think how to name and 

structure the documents and directories you create is at the start of a project. 

The principles of naming conventions can equally be applied to electronic and physical 

files/folders/material. 

5.3. Benefits of naming conventions 

Naming records consistently, logically and in a predictable way will distinguish similar 

records from one another at a glance, and by doing so will facilitate the storage and retrieval 

of data.  Through consistency and the application of logical standards we benefit from secure 

storage, and the ability to locate and access information. 

Suggested file and folder naming conventions 

 Keep file and folder names short, but meaningful. 

 Avoid unnecessary repetition and redundant words in file names and file paths. 

 Use capital letters to delimit words, not spaces. 

When including a number in a file name always give it as a two-digit number rather than one, 

i.e. 01, 02 … 99, unless it is a year or another number with more than two digits. 

 

 When including a personal name in a file name give the family name first followed by 

the initials. 
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 Avoid using common words such as ‗draft‘ or ‗letter‘ at the start of file names, unless 

doing so will make it easier to retrieve the record. 

 Order the elements in a file name in the most appropriate way to retrieve the record. 

 

5.4. Saving at different storage locations  

If you frequently save your documents in a different place on your hard drive rather than the 

My Documents folder, it can get tiresome navigating through the folders on your hard drive in 

the Save dialog box. Fortunately, the default location where Word saves your files can be 

easily changed. 

 

5.5. Creating, Opening, and Saving Documents 

It can start by creating a document, and you end by saving your work. Sounds simple, but to 

manage your Word documents effectively, you need to know these basics and beyond. This 

session shows you all the different ways to create a new Word document like starting from 

an existing document or adding text to a predesigned template and how to choose the best 

one for your particular project. 

 

Figure -33.saving a document 

https://www.lifewire.com/microsoft-word-4159373
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Self-Check -5 True/False 

 

Direction I:True/False 

Instruction: Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. A directory is defined as an organizational unit, or container, used to 

organize folders and files into a hierarchical structure. 

2. The main difference is that a folder is a logical concept that does not necessarily map 

to a physical directory. 

3. Through consistency and the application of logical standards we benefit from secure 

storage, and the ability to locate and access information. 

 

Note: Satisfactory rating – 3 and above points          Unsatisfactory - below 3 points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

3._____ 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Information Sheet 6 Printing of document  

 

6.1. Introduction to printing document 

In a traditional sense, printing means producing your document on paper. The printing process 

on the computer, however, is much more flexible than this. In Microsoft Word the printing 

commands allow you to control how the document will be printed, where it will be printed and 

what will be printed. 

Printing, in its simplest form, means producing a paper copy of a document that you have 

created on the computer. Early forms of printing required typesetting, printing presses and ink. 

These days, printing only requires a printer that converts the electronic form of the document 

into letters and other graphics on a page.  

 

Figure -34: Printing document. 

 

If you want to print more than one page but not the entire document, you can specify a range 

of determine this by previewing the pages and checking the page numbers below the preview. 

You then use a special format to specify individual pages or a series of consecutive pages 

(range). pages. To do this, you need to know the page numbers of the pages you want to 

print.  
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Figure -34: Printing by page 
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Self-Check -6 True/False 

 

Direction I: True/False 

Instruction: Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. In a traditional sense, printing means producing your document on paper 

2. Early forms of printing required typesetting, printing presses and ink. 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Operation sheet 1  create a table 

 

OPERATIONTITLE: creating a table 

PURPOSE:  To create a table 

EQUIPMENT TOOLS AND MATERIALS:-Glove, desktop computer, mouse, monitor, 

keyboard. 

PROCEDURES:- 

Step 1. Insert a table by using the Insert Table dialog box or the Insert Table button on the 

Standard Toolbar. 

 

Step 2. Draw a table by using the Tables and Borders Toolbar. 

 

Columns, Rows and Cells in a Table 
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Precaution: use computer safety accessories. 

Quality criteria: create a table properly 
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Operation sheet 2  Locate clip art 

 

OPERATIONTITLE: Locating clip art 

PURPOSE:  To locate clip art 

EQUIPMENT TOOLS AND MATERIALS:-Glove, desktop computer, mouse, monitor, 

keyboard. 

PROCEDURES:- 

 

Step 1.Select the Insert tab. 

Step 2.Click the Clip Art command in the Illustrations group. 

 

Step 3.The clip art options appear in the task pane on the right. 

Step 4.Enter keywords in the Search for: field that are related to the image you want to 

insert. 

Step 5.Click the drop-down arrow next to the Search  

 

Precaution: use computer safety accessories. 

Quality criteria: locate clip art properly 
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Operation sheet 3 Inserting and deleting columns and rows 

 

OPERATIONTITLE: Inserting and deleting columns and rows 

PURPOSE:  To Insert and delete columns and rows 

EQUIPMENT TOOLS AND MATERIALS:-Glove, desktop computer, mouse, monitor, 

keyboard. 

PROCEDURES:- 

Step 1.Add a cell, row, or column 

Step 2.Add a cell 

Step 3.Click in a cell that is located just to the right of or above where you want to insert a 

cell. 

Step 4.Under Table Tools, on the Layout tab, click the Rows & Columns Dialog Box 

Launcher. 

 

Precaution: use computer safety accessories. 

Quality criteria: Insert and delete columns and rows properly 
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Operation sheet 4 Creating a folder 

OPERATIONTITLE: creating a folder 

PURPOSE:  To create a folder 

EQUIPMENT TOOLS AND MATERIALS:-Glove, desktop computer, mouse, monitor, 

keyboard. 

PROCEDURES:- 

Step 1.With your document open, click File > Save As. 

Step 2.Under Save As, select where you want to create your new folder. You might need to 

click Browse or Computer, and navigate to the location for your new folder. 

Step 3.In the Save As dialog box that opens, click New Folder. 

 

Step4.Type the name of your new folder, and press Enter. 

 

Note: You can‘t use slashes, colons, semicolons, dashes, or periods in your folder name. 

 

 

Step 5.Click Save. Your document is saved to the new folder. 

Precaution: use computer safety accessories. 

Quality criteria: Insert and delete columns and rows properly 
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LAP-Test Practical Demonstration 

 

Project Title: Create tables and add images to word document 

Name:           ______________________                       Date:  ________________ 

Time started: _______________________ Time finished:  ___________ 

 

Instructions: Perform the following task properly within 2 hour. 

Task 1: Create table  

Task 2.Locate clip art 

Task 3.Insert and delete column and row 

            Task 4.Create a folder 
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Instruction sheet 
Learning Guide 41:  Use appropriate spreadsheet 

software 

 

This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics –  

 Selecting spreadsheet software  

 Identifying  document purpose, audience and presentation requirements 

 Opening  the spreadsheet application, create spreadsheet files  

 Entering  simple formulas and functions  

 Using a range of common tools in spreadsheet development 

 Editing columns and rows within the spreadsheet 

 Using the auto fill function to increment data  

 Naming and storing documents in appropriate directories or folders  

 

This guide will also assist you to attain the learning outcome stated in the cover page. 

Specifically, upon completion of this Learning Guide, you will be able to – 

 Select spreadsheet software  

 Identify document purpose, audience and presentation requirements 

 Open the spreadsheet application, create spreadsheet files  

 Enter simple formulas and functions  

 Use a range of common tools in spreadsheet development 

 Edit columns and rows within the spreadsheet 

 Use the auto fill function to increment data  

 Name and store documents in appropriate directories or folders  

 

 

 

 

 

 

 

Learning Instructions:  

1. Read the specific objectives of this Learning Guide.  
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2. Follow the instructions described below  

3. Read the information written in the ―Information Sheets 1- 6‖. Try to understand what are 

being discussed.  

4. Accomplish the ―Self-checks1, 2, 3, 4, 5 and 6‖ in each information sheets on pages 4, 

11,14,19,23 and 26. 

5. Ask from your teacher the key to correction (key answers) or you can request your 

teacher to correct your work. (You are to get the key answer only after you finished 

answering the Self-checks).  

6.If you earned a satisfactory evaluation proceed to ―Operation sheets 1, 2 and 3 on pages 

28,29 and 30.and do the LAP Test on page 31‖.  However, if your rating is unsatisfactory, 

see your teacher for further instructions or go back to Learning Activity.  

7. After you accomplish Operation sheets and LAP Tests, ensure you have a formative 

assessment and get a satisfactory result; then proceed to the next LG. 
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Information Sheet 1                Selecting spreadsheet software  

 

1.1. Spreadsheet software 

Spreadsheet software is a software application capable of organizing, storing and analyzing 

data in tabular form. The application can provide digital simulation of paper accounting 

worksheets. Spreadsheet software is also known as a spreadsheet program 

or spreadsheet application. A spreadsheet or worksheet is a file made of rows and columns 

that help sort data, arrange data easily, and calculate numerical data. What makes a spread 

sheet software program unique is its ability to calculate values using 

mathematical formulas and the data in cells. A good example of how a spreadsheet may be 

utilized is creating an overview of your bank's balance. 

Spreadsheets were developed to store, analyses and manipulate data. They are now 

commonly used for working with sets of data containing both text and numbers. 

 Every spreadsheet consists of a large grid of cells to store data which can then be 

manipulated using formula. 

 Each cell has an address which consists of the column letter and row number 

 Many spreadsheet documents contain several individual sheets that can reference 

values in other sheets in the file 

 Spreadsheets can also produce graphs and other data visualizations 

1.2. Types of spread sheet software 

1.2.1.Microsoft Excel 

Most good spreadsheets have very similar capabilities, but the syntax of the commands 

differs slightly. I will use the keyboard command and mouse syntax of Excel® by Microsoft 

for this example. I am assuming you have a mouse. In what follows, what you enter on the 

keyboard will be in bold. Special keys, like the key labelled ―Enter‖ will be written as: 

<Enter>, and menu options will be bold-italic. Let‘s suppose you have a number of data 

points such as data on a series of cylinders.  

 

https://www.computerhope.com/jargon/r/row.htm
https://www.computerhope.com/jargon/c/column.htm
https://www.computerhope.com/jargon/n/numeric.htm
https://www.computerhope.com/jargon/s/software.htm
https://www.computerhope.com/jargon/f/formula.htm
https://www.computerhope.com/jargon/c/cell.htm
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You want to perform some statistical analysis, perhaps to find the sum, mean and standard 

deviation of the various data sets. The first step is to set up the organization of the rows 

and/or columns. 

 

 

Figure -33.microsoft excel work space 

Gnumeric (Web, IOS, Android): Best spreadsheet software for collaboration. Google 

Sheets gives Excel a run for its money in terms of name recognition. And all you need to use 

it is a free Google account, which you already have if you use Gmail. It's tightly integrated 

with all of the other Google apps you use including Google Analytics, Google Data Studio, 

and Google Forms. 

Open office:-Best spreadsheet software for a free, native solution.  In practice, Libre Office 

Calc feels like an old version of Excel. Libre Office is a completely free and open source 

productivity suite, which began life as a fork of Open Office. The result is a basic 

spreadsheet app that contains all the functionality you'd expect from a native modern 

spreadsheet app on a budget. 

Apple iWork’s:-is an applications created by Apple Inc. for its mac OS and iOS operating 

systems, and also available cross-platform through the I Cloud websites a collection of 

bundled productivity software (a software suite) intended to be used by knowledge workers.  

 

http://sheets.google.com/?utm_source=zapier.com&utm_medium=referral&utm_campaign=zapier
http://sheets.google.com/?utm_source=zapier.com&utm_medium=referral&utm_campaign=zapier
http://sheets.google.com/?utm_source=zapier.com&utm_medium=referral&utm_campaign=zapier
http://libreoffice.org/?utm_source=zapier.com&utm_medium=referral&utm_campaign=zapier
http://libreoffice.org/?utm_source=zapier.com&utm_medium=referral&utm_campaign=zapier
http://libreoffice.org/?utm_source=zapier.com&utm_medium=referral&utm_campaign=zapier
https://en.wikipedia.org/wiki/Apple_Inc.
https://en.wikipedia.org/wiki/MacOS
https://en.wikipedia.org/wiki/IOS
https://en.wikipedia.org/wiki/Operating_system
https://en.wikipedia.org/wiki/Operating_system
https://en.wikipedia.org/wiki/Operating_system
https://en.wikipedia.org/wiki/ICloud
https://en.wikipedia.org/wiki/Software_suite
https://en.wikipedia.org/wiki/Knowledge_worker
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Self-Check -1 True/False 

 

Direction I: True/False 

Instruction: Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. Spreadsheet software is a software application capable of organizing, storing and 

analysing data in tabular form. 

2. Spreadsheets were developed to store, analyses and manipulate data 

3. Open office best spreadsheet software for a free, native solution 

4. Each cell has an address which consists of the column letter and row number 

 

 

Note: Satisfactory rating – 4 and above points          Unsatisfactory - below 4 points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

3._____ 

4._____ 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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InformationSheet2             Identify document purpose, audience and presentation 

requirements. 

 

2.1. Identifying Purposes spread sheet  

Spreadsheets can do practically anything. They can host your to-do list, help you reach your 

goals, and lead you to make better decisions. There's almost nothing you can't track using 

spreadsheet software. 

Finance: Spreadsheets are ideal for financial data, such as your checking account 

information, budgets, taxes, transactions, billing, invoices, receipts, forecasts, and any 

payment system. 

Forms: Form templates can be created to handle inventory, evaluations, performance 

reviews, quizzes, time sheets, patient information, and surveys. 

School and grades: Teachers can use spreadsheets to track students, calculate grades, 

and identify relevant data, such as high and low scores, missing tests, and students who are 

struggling. 

Lists: Managing a list in a spreadsheet is a great example of data that does not contain 

numbers, but still can be used in a spreadsheet. Great examples of spreadsheet lists include 

telephone, to-do, and grocery lists. 

Sports: Spreadsheets can keep track of your favorite player stats or stats on the whole 

team. With the collected data, you can also find averages, high scores, and statistical data. 

Spreadsheets can even be used to create tournament brackets 

 

 

 

 

 

https://zapier.com/blog/google-sheets-to-do-list/
https://zapier.com/blog/smart-goals/
https://zapier.com/blog/smart-goals/
https://zapier.com/blog/smart-goals/
https://zapier.com/blog/decision-matrix-template/
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Self-Check -2 True/False 

 

Direction I:True/False 

Instruction: Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. Spreadsheets can do practically anything. 

2. Spreadsheets can keep track of your favourite player stats or stats on the whole team. 

3. Managing a list in a spreadsheet is a great example of data that does not contain 

numbers, but still can be used in a spreadsheet. 

 

 

Note: Satisfactory rating – 3 and above points           Unsatisfactory - below 3 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

3_____ 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Information Sheet 3 Open the spreadsheet application create spreadsheet files 

 

3.1. Application of spread sheet 

In spreadsheet software appeared on mainframe computers, spreadsheets have evolved 

from simple tables and calculators to powerful tools for manipulating massive data sets. 

The software has been chosen for displaying a sense of value, regardless of which price 

point it targets. There is no expectation that free products will stand shoulder-to-shoulder 

with pricey subscription models. 

Finally, if you're going to be spending a lot of time in a spreadsheet, it's important that it's 

easy to use and pleasant to look at. User interface design and overall user experience have 

been taken into account while reviewing this software. 

 Applications that track, analyze, and chart numeric information,  

 Used for business, industry, education, and individuals to make financial decision 

 Microsoft Excel is an electronic spreadsheet program 

 

3.2. Create spread sheet files 

To create a spreadsheet, you must either have a spreadsheet program installed on your 

computer capable of creating a spreadsheet or use an online service capable of creating a 

spreadsheet. 

 

Figure -35: create spread sheet 
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Figure -36: Spread sheet format  
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Self-Check -3 True/False 

Direction I: True/False 

Instruction: Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. In spreadsheet software appeared on mainframe computers, spreadsheets have 

evolved from simple tables and calculators to powerful tools for manipulating massive 

data sets. 

2. User interface design and overall user experience have been taken into account while 

reviewing this software. 

3. The software has been chosen for displaying a sense of value, regardless of which 

price point it targets. 

 

Note: Satisfactory rating – 3 and above points           Unsatisfactory - below 3 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

3._____ 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Information Sheet 4 Entering  simple formulas and functions in spread sheet 

 

4.1. Enter Simple Formula in spread sheet  

Creating formulas 

You can enter formulas in two ways, either directly into the cell itself, or at the input line. 

Either way, you need to start a formula with one of the following symbols: =, + or -. Starting 

with anything else causes the formula to be treated as if it were text. 

Operators in formulas 

Each cell on the worksheet can be used as a data holder or a place for data calculations. 

Entering data is accomplished simply by typing in the cell and moving to the next cell or 

pressing Enter. With formulas, the equals sign indicates that the cell will be used for a 

calculation. A mathematical calculation like 15 + 46 can be accomplished as shown below. 

 

Table 4.1 cell formula 

While the calculation on the left was accomplished in only one cell, the real power is shown 

on the right where the data is placed in cells and the calculation is performed using 

references back to the cells. In this case, cells B3 and B4 were the data holders with B5 the 

cell where the calculation was performed. Note that the formula was shown as =B3 + B4. 

The plus sign 
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Indicates that the contents of cells B3 and B4 are to be added together and then have the 

result in the cell holding the formula.  

Text operators 

It is common for users to place text in spreadsheets. To provide for variability in what and 

how this type of data is displayed, text can be joined together in pieces coming from different 

places on the spreadsheet. Below is an example. 

 

Table 4.2.text operators 

Text Concatenation 

In this example, specific pieces of the text were found in three different cells. To join these 

segments together, the formula also adds required spaces and punctuation housed within 

quotation marks resulting in a formula of =B6 & " " & C6 & ", " D6. The result is the 

concatenation into a date formatted in a particular sequence. 

 

Table 4.3.text concatenation 
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Self-Check -4 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. You can enter formulas in two ways, either directly into the cell itself, or at the input 

line. 

2. Each cell on the worksheet can be used as a data holder or a place for data 

calculations. 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Information Sheet 5 Using a range of common tools in spreadsheet 

development 

 

5.1. Tools in spread sheet development 

Excel's Flash Fill feature makes it easy to fill data in an Excel worksheet based on adjacent 

data patterns. Flash Fill looks at the surrounding data, and then it fills a range based on what 

it finds. You might, for example, use Flash Fill to separate names (or to join them together) 

when you have a column or columns of name data in the wrong format. 

 

Table 5.1.flash fill 

 Filter and Calculate with Tables 

When you're working with lists of data in Excel, the Format-as-Table option (in 

the Styles area of the Home tab) does a lot more than simply format your data. When you 

click in a list of data and apply a table format to the data using this tool, Excel also adds a 

filter to each column. 

 

Table 5.2.filter table 
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Most formulae need to reference cells or ranges. An alternative to the usual reference style 

(e.g. A1) is to assign nameswhich are used in place of the cell or range address.For 

example, =A1*B1might become =Cost*Quantity. 

They help reduce errors by: making spreadsheet formulae more meaningful avoiding the 

need for ‗dollar‘ referencesyou can name: a single cell, a whole columnor row, or a 

rectangular rangeof cells. 

5.2. Creating named ranges 

The methods are different in Excel and Google Sheets, but you should always first select the 

cell or range to be named. If you are working with listed values and the number of rows in 

use may Using named ranges. The names may now be used anywhere in a formula or 

function wherea cell reference or range would normally be used. Below is an example using 

named columns and a named cell.Cell B1 is named ‗VATrate‘, making this an implied 

absolute reference (only one cell has that name). Columns B, C, D and E are named as 

shown: change, select entire columns rather than just the rows currently in use. 

 

Table 5.3.creating ranges of cost 
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Self-Check -5 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. The methods are different in Excel and Google Sheets, but you should always first 

select the cell or range to be named. 

2. Flash Fill looks at the surrounding data, and then it fills a range based on what it finds. 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Information Sheet 6 Edit columns and rows within the spreadsheet  

 

6.1 Adding columns and rows  

When adding a new cell, you move (shift) the data around that cell down or to the right 

depending on how you choose to shift the data. If there is data in adjacent cells that line up 

with the selected cell, it will become unaligned. In some situations, it may be better to add a 

new column or add a new row instead of a new cell. 

 

6.2. Removing a Columns and rows 

When removing a cell, you move (shift) the data around that cell up or to the left depending 

on how you choose to shift the data. If there is data in adjacent cells that line up with the 

selected cell, it will become unaligned. 

A spreadsheet consists of cells arranged in rows and columns. Each cell can hold text, a 

number, or a mathematical formula. A cell is referred to by column and row, e.g., the upper 

left cell is cell A1. The cell right below that is A2, etc. 

Entering data before carrying out most commands, you must first select the part of the 

worksheet you want to work with. You may select a single cell or a range of cells, but a 

formula will only be applied to one cell at a time. When you 

 

Table 6.1.adding no in column 

 

 

https://www.computerhope.com/issues/ch000892.htm#add-column
https://www.computerhope.com/issues/ch000892.htm#add-column
https://www.computerhope.com/issues/ch000892.htm#add-column
https://www.computerhope.com/issues/ch000892.htm#add-row
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Self-Check -6 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. When adding a new cell, you move (shift) the data around that cell down or to the right 

depending on how you choose to shift the data. 

2. When removing a cell, you move (shift) the data around that cell up or to the left 

depending on how you choose to shift the data. 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Information sheet-7 Use auto fill function to increment data 

 

7.1. Autofill Using More Than One Starting Cell Value 

If you want Excel to recognize a series that is not a simple increment by 1, this can be done 

by typing the first two values of your series into the first and second cells of a range. Select 

both of these cells and again, drag the fill handle across the range to be filled. Excel will 

automatically recognize the pattern from the two initial cells and continue this across the 

selected range. 

Create a Linear Series with the Fill Handle 

 

Table 7.1.create linear series 

7.2. Fill Handle Right-Click Menu 

Enter the first number in the top cell. Hover until you see the Fill Handle and with the right 

mouse button, drag the Fill Handle until you have selected the cells to auto fill. 
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Table 7.2.fill handle menu 
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Self-Check -7 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. If you want Excel to recognize a series that is not a simple increment by 1, this can be 

done by typing the first two values of your series into the first and second cells of a 

range. 

2. Excel will automatically recognize the pattern from the two initial cells and continue 

this across the selected range. 

 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Information sheet-8 Naming and storing documents in appropriate directories or 

folders  

 

8.1. Naming and storing documents 

Choose this to store your spreadsheet somewhere on your computer‘s hard drive. This is the 

most common option. When you click Computer, Excel lists the folders where you recently 

saved or opened files. To save a file to one of these locations, select the folder. Or, click the 

big Browse button at the bottom to find a new location. Either way, Excel opens the familiar 

Save As window, where you type in a name for your file. 

 

 

Table 8.1 naming a folder 
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8.2. Storing files 

As everyone who‘s been alive for at least three days knows, you should save your work early 

and often. Excel is no exception.  

To save a file for the first time, choose. Either way, you end up at the Save As page in 

backstage view. 

 

Table 8.2.storing files 
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Self-Check -8 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. File is saved in view tool bar. 

2. Saving a file is important to remember. 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Operation sheet 1 Creating cell 

 

OPERATIONTITLE:creating cell 

PURPOSE:  To create cell 

EQUIPMENT TOOLS AND MATERIALS:-Glove, desktop computer, mouse, monitor, 

keyboard. 

PROCEDURES:- 

Step 1.Click the cell in which you want to enter the formula. 

Step 2.In the formula bar  , type = (equal sign). 

Step 3.Do one of the following, select the cell that contains the value you want or type its cell 

reference 

Step 4.When selecting a range of cells, you can drag the border of the cell selection to move 

the selection, or drag the corner of the border to expand the selection. 

 

Step 5.The first cell reference is B3, the color is blue, and the cell range has a blue border 

with square corners. 

Step 6.The second cell reference is C3, the color is green, and the cell range has a green 

border with square corners. 

Step 7.Press Enter 

Precaution: use computer safety accessories. 

Quality criteria: creating cell properly 

 

Operation sheet 2 Creating formula using cell references 

 

OPERATIONTITLE:Creating formula using cell references 

PURPOSE:  To create formula using cell references 

EQUIPMENT TOOLS AND MATERIALS:-Glove, desktop computer, mouse, monitor, 

keyboard. 

PROCEDURES:- 

Step 1.Select the cell where the answer will appear (B3, for example). 
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Step2.Type the equals sign (=). 

Step 3.Type the cell address that contains the first number in the equation 

(B1, for example). 

 

Step 4.Type the operator you need for your formula. For example, type 

the addition sign (+). 

Step 5.Type the cell address that contains the second number in the equation 

(B2, for example). 

 

 

Step 6.Press Enter. The formula will be calculated, and the value will be 

displayed in the cell. 

 

Step 7.If you change a value in either B1 or B2, the total will automatically recalculate. 
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Step 8.enter 

Precaution: use computer safety accessories. 

Quality criteria: creating formula using cell references properly 

 

 

 

LAP-Test Practical Demonstration 

 

Project Title: Using appropriate spreadsheet software 

Name:           ______________________                       Date:  ________________ 

Timestarted: _______________________ Timefinished:  ___________ 

 

Instructions: Perform the following task properly within 2 hour. 

Task 1:Create cell 

Task 2.Create formula using cell references 
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Instruction sheet 
Learning Guide 42:  Incorporate object and chart in 

spreadsheet 

 

This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics –  

 Importing  an object into an active spreadsheet 

 Manipulating imported object by using formatting features 

 Creating a chart using selected data in the spreadsheet 

 Displaying selected data in a different chart 

 Modifying chart using formatting features 

 

This guide will also assist you to attain the learning outcome stated in the cover page. 

Specifically, upon completion of this Learning Guide, you will be able to – 

 Importan object into an active spreadsheet 

 Manipulate imported object by using formatting features 

 Create a chart using selected data in the spreadsheet 

 Display selected data in a different chart 

 Modify chart using formatting features 

 

Learning Instructions:  

1. Read the specific objectives of this Learning Guide.  

2. Follow the instructions described below  

3. Read the information written in the ―Information Sheets 1- 6‖. Try to understand what are 

being discussed.  

4. Accomplish the ―Self-checks1, 2, 3, 4, 5 and 6‖ in each information sheets on pages 4, 

11,14,19,23 and 26. 

5. Ask from your teacher the key to correction (key answers) or you can request your 

teacher to correct your work. (You are to get the key answer only after you finished 

answering the Self-checks).  

6.If you earned a satisfactory evaluation proceed to ―Operation sheets 1, 2 and 3 on pages 

28,29 and 30.and do the LAP Test on page 31‖.  However, if your rating is unsatisfactory, 

see your teacher for further instructions or go back to Learning Activity.  

7. After you accomplish Operation sheets and LAP Tests, ensure you have a formative 

assessment and get a satisfactory result; then proceed to the next LG. 
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Information sheet-1 Importing  an object into an active spreadsheet 

If you don‘t need to make a data visualization, you can also create a table in Excel using 

preexisting data. There are two ways to format a data set as a table: 

Manually: In this example, we manually added data and formatted as a table by including 

column and row names (products and years). 

Use Excel‘s Format as Table Preset: You can also input raw data (numbers without any 

column and row names). 

 

Table 1.1.Import an object  
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Self-Check -1 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. If you don‘t need to make a data visualization, you can also create a table in Excel 

using pre-existing data. 

2. You can also input raw data (numbers without any column and row names). 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Information sheet-2 Manipulating imported object by using formatting features 

2.1Import a file by formatting features 

You can get the best possible results for text in your PDF documents by choosing to import 

the text as text or as curves. The following pointers will help you make the right choice: 

When text is imported as text, the font and text are preserved, and the text is fully editable as 

artistic or paragraph text. However, some effects and formatting may be lost. This option is 

recommended if you have a PDF file that contains large blocks of text, such as a newsletter, 

and you want to reformat the text or add text content.  

When text is imported as curves, the appearance of the text, including all effects applied to it, 

are preserved, and each letter is converted to a curve object. With this option, the text 

formatting features can no longer be used to edit the text. If you have a PDF file that contains 

a small amount of text that does not require editing, or if you do not have the fonts used in 

the PDF file, you should import the text as curves. 

Text: - lets you edit and reformat the text from the PDF file. If any of the fonts used in the 

PDF file are missing, choose the settings you want in the Font substitution for missing fonts. 

Curves - converts text to curves, letting you maintain the appearance of the original text 

 

 

Table2.1 Import dialog box 

 

  

 

Self-Check -2 True/False 

 

Direction I:True/False 
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Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. You can get the best possible results for text in your PDF documents by choosing to 

import the text as text or as curves. 

2. When text is imported as curves, the appearance of the text, including all effects 

applied to it, are preserved, and each letter is converted to a curve object. 

 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Information sheet-3 Creating a chart using selected data in the spreadsheet 

 

3.1.Creating chart in spread sheet  

 

In general, a chart is a graphical representation of data. Charts allow users to see what the 

results of data to better understand and predict current and future data. The picture below 

contains an example of a column chart displaying the number of unique visitors Computer 

Hope has received between the years of 2000 and 2006. In this example, you'll notice a gentle 

increase of users without reading any data. 

 

Table 3.1.create chart 

Types of charts: there are a wide variety of charts available to display data. The list below 

contains those that are most popular and supported by many programs. Bar chart, Column 

chart, Excel Sparkline, Flow chart, Gantt chart, Graph, Line chart, Pie chart Point chart, 

Create chart or graph directly in Microsoft. 

3.2. Formulate chart in spread sheet: -Chart data series names Excel also uses column or 

row headings in the worksheet data for series names. Series names appear in the chart 

legend. In the example above, the row headings Projected and Actual appear as series 

names. You can change whether Excel uses column or row headings for series names or 

create different names. 

Line charts are usually set up to go across a period of time, think Time Line. For this chart 

I've used the Switch Row Column tool so we can see the trend of the sales through the year. 

In this case our first column titles appear in the legend, and the first row of titles appears in 

our category axis.  

 

 

 

https://www.computerhope.com/jargon/g/graphic.htm
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Pie charts are usually created to display the breakdown of the total values within the whole. 

Pie charts can only be based on one set of data. When you try to create one with the above 

dataset, you will only see the first value set appear within the chart. If you want to go to an 

extreme and have all four quarters show, try using a Doughnut chart. 

 

 

Table3.2.formulate chart 

 

 

 

 

 

 

 

Self-Check -3 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 
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1.  Chart is a graphical representation of data. 

2. Series names appear in the chart legend. 

3. Pie charts are usually created to display the breakdown of the total values within the 

whole. 

4. Line charts are usually set up to go across a period of time, think Time Line 

 

Note: Satisfactory rating – 4 and above points           Unsatisfactory - below 4 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

https://www.computerhope.com/jargon/g/graphic.htm
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Information sheet-4 Displaying selected data in a different chart 

4.1. How to create a chart or graph in Excel or Sheets 

Charts and graphs can help illustrate important information needing to be conveyed to other 

people. Common examples of data displayed in a chart are sales information for a month or year 

or showing trends in the stock market. 

 4.2. Create chart or graph in Microsoft Excel and copy to Microsoft Word 

Microsoft Excel provides more functionality and data manipulation capabilities than Microsoft Word 

provides when creating a chart or graph. If you need the increased capabilities of Excel to create a 

chart or graph, and then put it in a Microsoft Word document, follow the steps below. 

 

Table4.1.column chart 

4.3. Edit an existing chart 

If a chart already exists in the document you are editing, you can change any of the chart's 

properties by double-clicking on the portion of the chart you want to edit. For example, 

double-clicking a chart allows you to customize the colors, lines, and background values of 

the chart. Like in Microsoft Excel, Microsoft Word provides 

4.4. Displaying data to a different Chart 

As we have discussed above there are different types of chart we can display data as different 

form. Once you input your data and select the cell range, you‘re ready to choose your chart 

type to display your data. In this example, we‘ll create a clustered column chart from the data 

we used in the previous section. 

4.5. Making in Graph in Excel/spreadsheet  

Although graphs and charts are distinct, Excel groups all graphs under the charts categories 

listed in the previous sections. To create a graph or another chart type, follow the steps 

below and select the appropriate graph type. 

4.6. Manipulating Chart  

Once your data is highlighted in the Workbook, click the Insert tab on the top banner. About 

halfway across the toolbar is a section with several chart options. Excel provides 

Recommended Charts based on popularity, but you can click any of the dropdown menus to 

https://www.computerhope.com/jargon/e/excel.htm
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select a different template there are two tabs on the toolbar that you will use to make 

adjustments to your chart:  Excel automatically applies design, layout, and format presets to 

charts and graphs, but you can add customization by exploring the tabs. 

 

Table 4.2 Chart 

 

 

Self-Check -4 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

 

1. Charts and graphs can help illustrate important information needing to be conveyed to 

other people 

2. Microsoft Excel provides more functionality and data manipulation capabilities than 

Microsoft Word provides when creating a chart or graph. 

3. Once you input your data and select the cell range, you‘re ready to choose your chart 

type to display your data. 

4. If a chart already exists in the document you are editing, you can change any of the 

chart's properties by double-clicking on the portion of the chart you want to edit. 

 

Note: Satisfactory rating – 4 and above points           Unsatisfactory - below 4 

points  

 

Answer Sheet 

 

 

Score = ___________ 

Rating: ____________ 
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Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

3._____ 

4._____ 

 

 

Information sheet-5 Modifying chart using formatting features 

 

5.1. Modifying chart 

 

Modify chart helps you display your data into a graphical representation. There are many 

types of charts, but in this class we'll focus on simple column, line, and pie charts. There are 

examples of other charts near the end of this handouts.  The first thing to know is the data 

has to be organized so Excel can understand what you are trying to chart. Excel will chart 

your data selection or your connected data range. As long as there are no blank columns 

and no blank rows within your dataset, you can skip selecting the cells. 

 

Table 5.1 Modify chart 
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Excel provides you different types of charts that suit your purpose. Based on the type of 

data, you can create a chart. You can also change the chart type later. Excel offers the 

following major chart types- 

Line charts can show continuous data over time on an evenly scaled Axis. Therefore, they 

are ideal for showing trends in data at equal intervals, such as months, quarters or years. In 

a Line chart- Category data is distributed evenly along the horizontal axis.  Value data is 

distributed evenly along the vertical axis. 
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Self-Check -5 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. Modify chart helps you display your data into a graphical representation. 

2. Excel will chart your data selection or your connected data range. 

3. As long as there are no blank columns and no blank rows within your dataset, you can 

skip selecting the cells. 

 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

3._____ 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Operation sheet 1  setting document in spread sheet 

OPERATIONTITLE:setting document in spread sheet 

PURPOSE:  To set document in spread sheet 

EQUIPMENT TOOLS AND MATERIALS:-Glove, desktop computer, mouse, monitor, 

keyboard. 

PROCEDURES:- 

Step 1.To format data as a table, click and drag your mouse across the cells with the 

data range, click the Home tab, and click the Format as Table drop-down menu on the 

toolbar.  

Step 2.Click New Table Style… (You will also see an option to use PivotTables. This 

feature is outside the scope of this how-to, but the concept is explained in the 

following 

section).  

Step 3.A dialogue box opens and you can choose which aspects of the selected 

range to include in your formatted table. Click the 

blue OK button.  

Precaution: use computer safety accessories. 

Quality criteria: setting document properly. 
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Operation sheet 2 Inserting  a picture into cell 

 

OPERATIONTITLE:Insert a picture into a cell 

PURPOSE:  To insert a picture into a cell 

EQUIPMENT TOOLS AND MATERIALS:-Glove, desktop computer, mouse, monitor, 

keyboard. 

PROCEDURES: 

Step 1.Go to the Insert tab. 

Step 2.Click on the Pictures option (it‘s in the illustrations 

group).  

Step 3.In the ‗Insert Picture‘ dialog box, locate the pictures that you want to insert into a cell 

in cell. 

.  

 

 

Step 4.Click on the Insert 

button.
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Step 5. Re-size the picture/image so that it can fit perfectly to cell  

 

.  

 

Precaution: use computer safety accessories. 

Quality criteria: Inserting a picture into cell properly. 
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Operation sheet 3  Create chart or graph in Microsoft excel. 

 

OPERATIONTITLE:Creating chart or graph in Microsoft excel 

PURPOSE:  Tocreatechart or graph in Microsoft excel 

EQUIPMENT TOOLS AND MATERIALS:-Glove, desktop computer, mouse, monitor, 

keyboard. 

PROCEDURES: 

Step1.Create the chart or graph in Microsoft Excel. 

Step2.After the chart or graph is created and ready to be placed in the Word document, select the 

entire chart in Excel. 

Step3.Right-click on the chart or graph and select the Copy option. You can also press Ctrl+C on 

your keyboard to copy the chart or graph. 

Step 4.In the Word document, place your mouse cursor where you want to add the chart or graph. 

Step5.Right-click and select the Paste option to place the chart or graph in the 

document.  

Step6.You can also press Ctrl+V on your keyboard to paste the chart or graph. 

Precaution: use computer safety accessories. 

Quality criteria:creating chart or graph in Microsoft excelproperly. 

 

 

 

 

 

https://www.computerhope.com/issues/ch000911.htm
https://www.computerhope.com/jargon/r/righclic.htm
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Operation sheet 4  Selecting  range to create graph 

PERATIONTITLE:Selecting range to create graph 

PURPOSE:  ToSelect range to create graph 

EQUIPMENT TOOLS AND MATERIALS:-Glove, desktop computer, mouse, monitor, 

keyboard. 

PROCEDURES: 

Step 1.Highlight the cells that contain the data you want to use in your graph by 

clicking and dragging your mouse across the cells. 

Step 2.Your cell range will now be highlighted in 

gray.  

Step3.Once the text is highlighted you can select a graph (which Excel refers to as 

chart). Click the Insert tab and click Recommended Charts on the toolbar. Then click 

the type of graph you wish to 

use.

  

Precaution: use computer safety accessories. 

Quality criteria:selecting range to create a graphproperly. 
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LAP-Test Practical Demonstration 

 

Project Title: Incorporate object and chart in spreadsheet 

Name:           ______________________                       Date:  ________________ 

Timestarted: _______________________ Timefinished:  ___________ 

 

Instructions: Perform the following task properly within 2 hour. 

Task 1: Set document in spread sheet 

Task 2.Insert a picture into a cell 

Task 3.Create chart or graph in Microsoft excel 

Task 4. Select range to create graph 
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Instruction sheet Learning Guide 43:  Create database 

 

This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics –  

 Opening a database application and design Principles 

 Developing a table with fields and attributes  

 Creating a primary key and establish an index for each table 

 Modifying table layout and field attributes  

 Creating a relationship between two tables 

 Adding and modifying data in a table 

 Adding and deleting records  

 Saving and closing down database to storage area 

This guide will also assist you to attain the learning outcome stated in the cover page. 

Specifically, upon completion of this Learning Guide, you will be able to – 

 Open a database application and design Principles 

 Develop a table with fields and attributes  

 Creating a primary key and establish an index for each table 

 Modify table layout and field attributes  

 Create a relationship between two tables 

 Adding and modify data in a table 

 Add and delete records  

 Save and close down database to storage area 
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Learning Instructions:  

1. Read the specific objectives of this Learning Guide.  

2. Follow the instructions described below  

3. Read the information written in the ―Information Sheets 1- 6‖. Try to understand what are 

being discussed.  

4. Accomplish the ―Self-checks1, 2, 3, 4, 5 and 6‖ in each information sheets on pages 4, 

11,14,19,23 and 26. 

5. Ask from your teacher the key to correction (key answers) or you can request your 

teacher to correct your work. (You are to get the key answer only after you finished 

answering the Self-checks).  

6.If you earned a satisfactory evaluation proceed to ―Operation sheets 1, 2 and 3 on pages 

28,29 and 30.and do the LAP Test on page 31‖.  However, if your rating is unsatisfactory, 

see your teacher for further instructions or go back to Learning Activity.  

7. After you accomplish Operation sheets and LAP Tests, ensure you have a formative 

assessment and get a satisfactory result; then proceed to the next LG. 
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Information sheet-1 Opening a database application and design Principles 

 

1.1. Database its Application  

A database is a gathering of information, here called data, stored on a server. The data is 

organized in a way it can easily be retrieved, managed and edited in significant ways by the 

end-user. The data could be something very simple such as personal information about 

clients or customers. It could also be inventory, sales, calls or anything anyone needs to 

track.  

 

A database is a collection of related data which represents some aspect of the real world. A 

database system is designed to be built and populated with data for a certain task. 

A database application is a computer program whose primary purpose is entering and 

retrieving information from a computerized database.  

Database applications allow users to gain access to the data they need. More importantly, 

they filter out any unnecessary data, permitting users to only have access to the records that 

they need.Database Management System (also known as DBMS) is a software for storing 

and retrieving users' data by considering appropriate security measures. 

1.2. Characteristics of Database Management System 

 Provides security and removes redundancy 

 Self-describing nature of a database system 

 Insulation between programs and data abstraction 

 Support of multiple views of the data 

 Sharing of data and multiuser transaction processing 

 DBMS allows entities and relations among them to form tables. 

1.3. Database Design Principles 

There are six main objectives which must be fulfilled effectively by a good database. 

 Usability 

 Extensibility 

 Data Integrity 

 Performance 

 Availability 

 Security 



                                                            

Page 142 of 226 
 

Federal TVET Agency 
Author/Copyright  

Irrigation and drainage construction 
Level -II 

Version -2 

September 2019 

 

 

Figure 1.1 Data base design principles 

Usability:Following are few points to consider while going to start an architecture. 

 Properly get details about requirements. 

 See how information can be fit with requirement. 

 Trace requirement matrix to capture mapping of information architecture and 

requirements. 

 Organize it simple. 

 Decide upon format of data so that could be easily converted to meaningful 

representation. 

Extensibility:Following are few points to consider when thinking of extensibility. 

 Normalization and correct handling of optional data. 

 Generalization of entities when designing the schema. 

Entity Integrity:Involves the structure (primary key and its attributes) of the entity. If the 

primary key is unique and all attributes are scalar and fully dependent on the primary key, 

then the integrity of the entity is good. In the physical schema, the table‘s primary key 

enforces entity integrity. 

Referential Integrity: This defines if any entity is dependent on another one then parent 

entity should be there in the system and should be uniquely identifiable. We can do this by 

implementing foreign keys. 

 

Transactional Integrity: This defines that transaction should have its ACID properties. Any 

transaction should be atomic, consistent, durable and isolated. 
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User defined integrity: There are few business rules which we cannot validate just by 

primary keys, foreign keys etc. There has to be some mechanism so that we can validate 

complex rules for integrity. We can implement these rules in following ways: 

 Check Constraints 

 Triggers & Stored Procedures 

Performance: Following could be few strategies which we can implement when there is 

need as data increases. 

 A well-designed schema with normalization and generalization 

 A sound indexing strategy, including careful selection of clustered and non-clustered 

 Tight, fast transactions that reduce locking and blocking 

 Partitioning, which is useful for advanced scalability 

 

Security: For any organizational asset, the level of security must be secured depending on 

its value and sensitivity. Sometime organizations has suffered a lot because of data leaks 

which results in loss of faith and tends to business risk. So security is one of the most 

important aspect of good database design. 
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Self-Check -1 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. A database is a gathering of information, here called data, stored on a server. 

2. A database is a collection of related data which represents some aspect of the real 

world. 

3. Transactional Integrity defines that transaction should have its ACID properties. 

4. Referential Integrity defines if any entity is dependent on another one then parent 

entity should be there in the system and should be uniquely identifiable. 

 

Note: Satisfactory rating – 4 and above points           Unsatisfactory - below 4 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

3.____ 

4._____ 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Information sheet-2 Developing a table with fields and attributes  

 

2.1. Fields 

Fields are the components that provide structure for a table. In fact, you can't have a table 

without fields. For instance, you can create an empty table that has fields defined but no 

rows (records).In databases, fields are also used to maintain relationships between tables. 

This is done by having matching fields in two or more tables. For example, if you stored a 

table called toy store in a database and you also stored a staff table to track the employees 

in each store, you would create a common field between the two tables that would be 

populated with, for instance, a store ID. 

 

Table2.1.Employee table linked to store table with ID 

2.1.1. Field names 

Field names are the names you give to the columns in a table. The names should give an 

indication of what data is contained in that particular column. For example, when you create 

a new feature class in Arc Catalog, the table is already populated with an Object ID field and 

a shape field. The Object ID field contains the unique ID number for each object in the 

feature class. 

.  

Table 2.2.create field names 
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2.2.Attribute 

A database consists of tables. Each table has columns and rows. Each row (called a tuple) is 

a data set that applies to a single item. Each column (attribute) contains describing 

characteristics of the rows. A database attribute is a column name and the content of the 

fields under it in a table in a database. 

If you sell products and enter them into a table with columns for Product Name, Price, and 

Product ID, each of those headings is an attribute. In each field under those headings, you'll 

enter the product names, prices, and product IDs, respectively. Each one of the field entries 

is also an attribute. An attribute is a single piece of data in the tuple to which it belongs. Each 

tuple is a data set that applies to one item. This makes sense when you think of it, given that 

the nontechnical definition of an attribute is that it defines a characteristic or quality of 

something. 

2.3. Table 

Tables are very useful tools in creating and formatting documents. For example, with a table 

you can:  Align Text, Numbers, and Graphics: Tables make it easy to align text, numbers, 

and graphics in columns and rows. Many users prefer using tables to align text instead of tab 

stops, because text can wrap to multiple lines in a table.  Create a Form: You can use tables 

to store lists of telephone numbers, clients, and employee rosters.  Share Information: You 

can use tables to share information between programs.  

https://www.lifewire.com/databases-glossary-1019603
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Self-Check -2 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. Fields are the components that provide structure for a table 

2. A database attribute is a column name and the content of the fields under it in a table 

in a database. 

3. Field names are the names you give to the columns in a table. 

Note: Satisfactory rating – 3 and above points           Unsatisfactory - below 3 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

3._____ 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Information sheet-3 Creating a primary key and establish an index for each 

table 

 

3.1. The primary key 

Aprimarykeyisasinglefield or combination of fieldsin atablethat uniquelyidentifieseach 

record in that table.  No two records can havethe same valuein theprimary keyfield 

orcombination of fields. It isadvisableto create theprimary keybefore entering data in 

atablebecauseAccesswill prevent duplicate values beingcreated in the designatedfield. 

It isparticularly important to set aprimary key whencreatingrelationships 

betweentablesasAccessuses it to linktablestogether. 

3.2. Indexes of a table 

Indexing afield speeds updata accesswhen runningqueries, sorting, and grouping.  Ifyou 

regularly sort orsearch on certainfields it isagood ideato create anindexforthis field.  

However,indexes can slowdown some processing activities such asadding or 

deletingrecordsastheIndexes formanyfields need to beupdatedwhileperforming these 

operations.  Forthis reason,indexing should belimited to a fewimportant fields. 

Indexing can also be used to prevent duplicateentries in afield. 

 

 

 

Table 3.1.Multiple index 
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Self-Check -3 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. Aprimarykeyisasinglefield or combination of fieldsin atablethat uniquelyidentifieseach 

record in that table. 

2. Indexing afield speeds updata accesswhen runningqueries, sorting, and grouping. 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 



                                                            

Page 150 of 226 
 

Federal TVET Agency 
Author/Copyright  

Irrigation and drainage construction 
Level -II 

Version -2 

September 2019 

 

 

 

Information sheet-4 Customizing images 

 

  4.1. Modifying table design 

It ispossible to modify the design ofyourtable andfieldsat anytime bygoing todesignview 

and making the required changes.  However, any changes madeafter datahasbeen 

addedto thetablemaycause lossofdata.  Changestofieldnames,datatypesandproperties may 

also impact onotherobjects which are linked to or based on thetable. 

 

4.2.Addingandremovingfields 

You can modify the structure of your tableby adding and removingfieldsin designview.  

Note, however, that using thecut, paste ordelete functions will removethefield and any 

datainthatfield. 

 

4.3. Changing fieldsize 

Ifyou convert a largefieldsize setting to asmaller one in afield that alreadycontainsdata, 

you might lose data in thefield. Forexample,if youchange thefield size setting foratext 

datatype field from 255 to 50, data beyondthe 50characterswill be discarded.Ifthe data in 

anumber datatype field doesn't fit in anewfield size setting, fractional numbersmaybe 

rounded or you might get anull value. 
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Self-Check -4 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. It ispossible to modify the design ofyourtable andfieldsat anytime bygoing 

todesignview and making the required changes. 

2. You can modify the structure of your tableby adding and removingfieldsin designview. 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Information sheet-5 Create a relationship between two tables 

 

5.1. Create, edit or delete a relationship 

A relationship in Access helps you combine data from two different tables. Each relationship 

consists of fields in two tables with corresponding data. For example, you might have a 

ProductID field in a Products table and in an OrderDetails table. Each record in the 

OrderDetails table has a ProductID that corresponds to a record in the Products table with 

the same ProductID. 

When you use related tables in a query, the relationship lets Access determine which 

records from each table to combine in the result set.  

A relationship can also help prevent missing data, by keeping deleted data from getting out 

of synch, and this is called referential integrity. 

Before you work with relationships, make sure you understand the background concepts. For 

more information, see Guide to table relationships and get started with table relationships.In 

an Access database, you create a table relationship using one of the following methods: 

 In the Relationships window, add the tables that you want to relate, and then drag the 

field to relate them from one table to the other table. 

 Drag a field on to a table datasheet from the Field List pane. 

When you create a relationship between tables, the common fields are not required to have 

the same names, although it is often the case that they do. The common fields must have 

the same data type. If the primary key field is an AutoNumber field, however, the foreign key 

field can also be a Number field if the Field Size property of both fields is the same.  

 

Figure 5.1.Edit relationship 

 

https://support.office.com/en-gb/article/guide-to-table-relationships-30446197-4fbe-457b-b992-2f6fb812b58f
https://support.office.com/en-gb/article/video-get-started-with-table-relationships-728d53ff-f332-4ac6-9382-574ee271500a
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Self-Check -5 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. A relationship in Access helps you combine data from two different tables 

2. When you create a relationship between tables, the common fields are not required to 

have the same names, although it is often the case that they do. 

3. A relationship can also help prevent missing data, by keeping deleted data from 

getting out of synch, and this is called referential integrity. 

 

 

Note: Satisfactory rating – 3 and above points          Unsatisfactory - below 3 points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

3._____ 

 

 

 

 

 

 

 

Information sheet-6 Adding and modify data in a table 

 

6.1. Modifying the Data Design of a Table   

To modify any changestothe design ofatable, youneed toopen therelevanttable and click on 

the Designbutton. In Design view you can add new fields, change theproperties ofexisting 

fieldsand delete fieldsthat are no longer required. Ifyou make changes to their 

Score = ___________ 

Rating: ____________ 
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propertiesoffileswhich alreadycontain data, up will to consider whether he existing 

datameetsthesettings.   

 

Accesswill display warning messagesto indicate that your data could be changed withthenew 

properties.With changes to the fieldinformation, whither data types orproperties, ensurethat 

you save your updates.  Ifyou havemade changes to certain fields, forexample changing or 

adding avalidation rule, you will seethe followingmessageswhen you havesaved your 

changes. 

 

Ifyou clickyes, then Accesswill checkif any existing recordsdo not meet yourvalidation rule 

criteria. It will not tell you whichones orhow many. 

 

 

You will see theabovemessageif anyofyour recordsdonot meet the criteriaspecified 

in your validation rule. 

 

1.  Ifit is YesthenAccesswill keep your newsetting and continue testing 

2.  Ifit is Nothen the new setting will not be kept 

3.  if you ClickCancel, to keep thenew setting,but stop testing 

 

Self-Check -6 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 
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1. To modify any changestothe design ofatable, youneed toopen therelevanttable and 

click on the Designbutton. 

2. Accesswill display warning messagesto indicate that your data could be changed 

withthenew properties. 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Information Sheet 7                Add and delete records in a database  

7.1. Adding and deleting records 

Often, you‘ll need to add information to the database by creating new records, or you may 

need to change or delete an existing record. 

7.2. Copying a record 

Often, the most efficient way to create a new database record is to copy an existing one and 

modify it as necessary. There are two ways to do this: with the Copy Record command, or by 

dragging and dropping an item from a data list.With either method, Manager copies the data 

from the existing record to the new one; you can then edit fields as necessary and save. 

Note that certain types of records cannot be deleted, for example: 

 Customers with any associated transactions that resulted in sales 

 Sales transactions that are closed 

 Selections within sales transactions 

 Inventory that is used in a package or a transaction 

 Packages of type 'Empty' or 'Full' (requires Administrator privileges) 

javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);


                                                            

Page 157 of 226 
 

Federal TVET Agency 
Author/Copyright  

Irrigation and drainage construction 
Level -II 

Version -2 

September 2019 

 

  

Self-Check -7 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

 

1. Often, the most efficient way to create a new database record is to copy an existing 

one and modify it as necessary. 

2. Often, you‘ll need to add information to the database by creating new records, or you 

may need to change or delete an existing record. 

 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

 

 

 

 

 

 

 

 

Information Sheet 8 Save and close down database to storage area 

 

8.1. Introduction 

Score = ___________ 

Rating: ____________ 

javascript:void(0);
javascript:void(0);
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In persistent databases, they're stored in carefully formatted Computer files in structures that 

are installation-dependent. SQL databases usually use ―row-structured‖ storage, meaning 

each row in a table is stored in a contiguous block of memory. 

8.2. Disks(CD and DVD) 

CD: Compact disk is portable disk having data storage capacity between 650-700 MB. It can 

hold large amount of information such as music, full-motion videos, and text etc. CDs can be 

either read only or read write type. 

Digital Video Disk (DVD): is similar to a CD but has larger storage capacity and enormous 

clarity. Depending upon the disk type it can store several Gigabytes of data. DVDs are 

primarily used to store music or movies and can be played back on your television or the 

computer too. These are not rewritable. 

Primary Storage: Also known as main memory. Main memory is directly or indirectly 

connected to the central processing unit via a memory bus. The CPU continuously reads 

instructions stored there and executes them as required. Example: RAM, ROM, and Cache 

Secondary Storage: It is not directly accessible by the CPU. Computer usually uses its 

input/output channels to access secondary storage and transfers the desired data using 

intermediate area in primary storage. Example: Hard disk 

Tertiary Storage: Typically it involves a robotic mechanism which will mount (insert) and 

dismount removable mass storage media into a storage device. It is a comprehensive 

computer storage system that is usually very slow, so it is usually used to archive data that is 

not accessed frequently. This is primarily useful for extraordinarily large data stores, 

accessed without human operators. 

Examples: Magnetic Tape and Optical Disc 

8.3. External hard drive and USB flash drive 

A thumb drive, also called a USB drive or flash drive, is a small solid-state drive that 

connects to a device through a USB port. Because USB technology has become such a 

standard protocol, users can transfer files to and from most personal computers easily with 

these small, portable drives. 

 

The Zip drive is a removable floppy disk storage system that was introduced by Iomega in 

late 1994. Considered medium-to-high-capacity at the time of its release, Zip disks were 

originally launched with capacities of 100 MB, then 250 MB, and then 750 MB. 

https://en.wikipedia.org/wiki/Disk_storage
https://en.wikipedia.org/wiki/Iomega
https://en.wikipedia.org/wiki/Megabytes
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Figure 8.1.Exeternal hard disk 

 

8.4. Portable Hard Disk 

These are the same disks that are fixed in the computer, but these ones are the portable 

model. The larger disks have their own power supply and they can be connected via the 

USB and allow transfer speeds similar to those fixed in the computer 

 

Figure 8.2.Portable hard disk 

Memory Card:An electronic flash memory storage disk commonly used in consumer 

electronic devices such as digital cameras, MP3 players, mobile phones, and other small 

portable devices. Memory cards are usually read by connecting the device containing the 

card to your computer, or by using a USB card reader.  

 

Figure 8.3.Off-line Storage 

Also known as disconnected storage. Is a computer data storage on a medium or a device 

that is not under the control of a processing unit. It must be inserted or connected by a 

human operator before a computer can access it again. 

Examples: Floppy Disk, Zip diskette, USB Flash drive, Memory card 

8.5. Internal hard drive 
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Drive: On Windows computers, most of the files you work on are saved to the C: drive, 

which is the default drive. If you want to save to another drive such as a flash drive, you 

would need to know the drive letter and specify that drive letter when saving the file. 

Desktop: On Windows computers, you can save files to your Desktop, which can give you 

quick access to files you may frequently use. In fact desktop is a part of local hard drive of 

the computer. 

 

My Documents: On Windows computers, all document related files (e.g., word processor 

spreadsheet files) default to save in the My Documents folder automatically. We recommend 

keeping all documents in this folder to make it easier to backup all your important files. This 

is also a part of local hard drive of the computer. 

 

 

8.6. Save on database  

Network drives: These are storage drives that are connected to other computers in a 

network. Users on the network can save their files onto the drive. This approach is often 

used where alluserssave their files to a common location and this is backed up. It is much 

simpler tocopy the files from one common place instead of copying the files from individual 

computers. 

8.7. Close on data base 

The Music Dept. Inventory Database should be closed using the "Exit" button on the main 

menu.  The red "X" in the upper right corner has been disabled so that the database doesn't 

close improperly.  Please do not use the "File/Close Database" option as that will close the 

database without allowing it to close the forms and tables correctly. 

 

 

https://www.computerhope.com/jargon/c/ccol.htm
https://www.computerhope.com/jargon/j/jumpdriv.htm
https://www.computerhope.com/jargon/d/drivelet.htm
https://www.computerhope.com/jargon/d/desktop.htm
https://www.computerhope.com/jargon/w/word-processor.htm
https://www.computerhope.com/jargon/m/mydocume.htm
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Figure 8.4.Close database 

 

If you shut down the computer before the ―Compact‖ is finished (and MS Access has 

completely closed) or your workstation loses contact with the network you can corrupt the 

database - which means that it might not open again the next time you try.  Corrupted 

databases can sometimes be repaired and the data rescued but not always.  It is always a 

good idea to frequently do a back-up of the database to the hard disk or an external drive to 

be sure to have a recent copy. 
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Self-Check -8 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. Main memory is directly or indirectly connected to the central processing unit via a 

memory bus. 

2. Secondary Storageis not directly accessible by the CPU. 

3. Compact disk is portable disk having data storage capacity between 650-700 MB. 

 

Note: Satisfactory rating – 3 and above points           Unsatisfactory - below 3 

points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

3._____ 

 

 

 

Score = ___________ 

Rating: ____________ 
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Operation sheet-1 Creating new fields 

 

OPERATIONTITLE:Creating new fields 

PURPOSE: to create new fields 

EQUIPMENT TOOLS AND MATERIALS:-Desk top Computer, monitor, keyboard, mouse, 

hard disk, printer, cable, HDMI cable, CPU... 

PROCEDURE:    

Step 1.In the firstrow oftheFieldName column, typethename of your firstfield, following 

the naming conventionslisted above. 

Step 2.Pressthe Tab key to take you to theDataType field. 

Step 3.Click on thedrop-down arrow that appearsin the box to display alist of datatypes 

(seebelow) and select the appropriateone. 

Step 4.PressTab to take you to theDescriptionfield. Typein ashortmessagedescribing the 

currentfield. 

Step 5.  Pressthe Tab key to take you to the next row and backto theFieldNamecolumn. 

Step 6.Continue asaboveuntilyou have enteredall yourfieldsas shown below 

 

 

PRECAUTION: use computer safety as required. 

QUALITY CRITERIA:Creating new fields properly. 
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Operation sheet-2 Creating new record 

 

OPERATIONTITLE: Creating a new record 

PURPOSE: to create a new record 

EQUIPMENT TOOLS AND MATERIALS:-Desk top Computer, monitor, keyboard, mouse, 

hard disk, printer, cable, HDMI cable, CPU... 

PROCEDURES:- 

Step 1. On the data access bar, click the icon for the table where you want to add the new 

record. Manager opens a data list containing the results of the last search you made in this 

table. 

Step 2. On the data list windows tool bar, click the New Record icon (or choose Create 

NewRecord from the Edit menu or the right-click menu; keyboard shortcut Ctrl-N).  

Step 3. In the blank data dialog box, enter all available information for the new entry. Use the 

Tab key to move from field to field.. 

Step 4. When finished, click Save, or the diskette icon on the data dialogʼs tool bar.To save 

the record and create another new one immediately, click Save and New Record (Ctrl-Enter). 

Step 5. To close the dialog, click Close, or the Close button in the top right corner, or press 

esc.If you click close without first clicking Save, Manager will not save the record and your 

changes will be lost. 

 

PRECAUTION: use computer safety as required. 

QUALITY CRITERIA:Creating new record properly. 

 

 

 

https://www.secureclub.net/Help/acm/UG/ug_UI.htm#vertical
javascript:void(0);
javascript:void(0);
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Operation sheet-3 Database Design Process 

 

OPERATIONTITLE:Database Design Process 

PURPOSE: To DesignDatabase Process 

EQUIPMENT TOOLS AND MATERIALS:-Desk top Computer, monitor, keyboard, mouse, 

hard disk, printer, cable, HDMI cable, CPU... 

PROCEDURES:- 

Step 1: Define the Purpose of the Database  

Step 2: Gather Data, Organize in tables and Specify the Primary Keys 

Step 3: Create Relationships among Tables 

Step 4: Refine & Normalize the Design. 

 

PRECAUTION: use computer safety as required. 

QUALITY CRITERIA:Design data base properly. 
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LAP-Test Practical Demonstration 

 

Project Title: Creating database 

Name:           ______________________                       Date:  ________________ 

Timestarted: _______________________ Timefinished:  ___________ 

 

Instructions: Perform the following task in 2 hour recommended time. 

Task 1: Create new fields 

Task 2:Create a new record 

            Task 3.DesignDatabase Process 
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Instruction sheet Learning guide 44:-Create reports and forms 

 

Thislearningguideisdevelopedtoprovideyouthenecessaryinformationregardingthefollowing 

contentcoverage andtopics– 

 Designing reports to present data in a logical sequence 

 Modifying reports to include or exclude additional requirements 

 Distributing reports to appropriate person in a suitable format 

 Using a wizard to create a simple form 

 Opening existing database and modify records  

 Re arranging objects within the form  

Thisguidewillalsoassistyoutoattainthelearningoutcomestatedinthecoverpage.Specifically, upon 

completion of thisLearningGuide, you will be able to 

 Design reports to present data in a logical sequence 

 Modify reports to include or exclude additional requirements 

 Distribute reports to appropriate person in a suitable format 

 Use a wizard to create a simple form 

 Open existing database and modify records  

 Rearrange objects within the form  

Learning Instructions:  

1. Read the specific objectives of this Learning Guide.  

2. Follow the instructions described below  

3. Read the information written in the ―Information Sheets 1- 6‖. Try to understand what are 

being discussed.  

4. Accomplish the ―Self-checks1, 2, 3, 4, 5 and 6‖ in each information sheets on pages 4, 

11,14,19,23 and 26. 

5. Ask from your teacher the key to correction (key answers) or you can request your teacher 

to correct your work. (You are to get the key answer only after you finished answering the 

Self-checks).  

6.If you earned a satisfactory evaluation proceed to ―Operation sheets 1, 2 and 3 on pages 

28,29 and 30.and do the LAP Test on page 31‖.  However, if your rating is unsatisfactory, see 

your teacher for further instructions or go back to Learning Activity.  

7. After you accomplish Operation sheets and LAP Tests, ensure you have a formative 

assessment and get a satisfactory result; then proceed to the next LG. 
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Information Sheet 1 Designing  reports to present data in a logical sequence 

 

1.1. Design reports to present data in a logical sequence 

 Logical sequence 

In more general terms, logical sequence refers to any order of events or things that makes 

sense. For a very basic example, the logical sequence for getting dressed is to first put on the 

underclothes, then pants, shirt, socks, and shoes. Access provides you with a number of tools 

that help you to quickly build attractive, easy-to-read reports that present the data in a way that 

best suits the needs of its users.  

You can use the Report Wizard to create a more complicated report, or you can create a report 

by adding all the data and formatting elements yourself. Whichever method that you choose, 

you will probably make at least a few changes to the design of the report to make it display the 

data the way that you want.  

 Decide how to lay out your report 

When you design a report, you must first consider how you want the data arranged on the page 

and how the data is stored in the database. During the design process, you might even 

discover that the arrangement of data in the tables will not allow you to create the report that 

you want. This can be anindication that the tables are not normalized — this means that the 

data is not stored in the most efficient manner. 

 Decide which data to put in each report section 

Each report has one or more report sections. The one section that is present in every report is 

the Detail section. This section repeats once for each record in the table or query that the report 

is based on. Other sections are optional and repeat less often and are usually used to display 

information that is common to a group of records, a page of the report, or the entire report. 
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Self-Check -1 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. In more general terms, logical sequence refers to any order of events or things that 

makes sense. 

2. Each report has one or more report sections. 

3. When you design a report, you must first consider how you want the data arranged on 

the page and how the data is stored in the database. 

 

Note: Satisfactory rating – 3 and above points          Unsatisfactory - below 3 points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Information Sheet 2 Modifying reports to include or exclude additional 

requirements 

 

2.1.Customize and organize reports 

Analyze data in Dynamics 365 Customer Engagement (on-premises) by using reports. 

Dynamics 365 Customer Engagement (on-premises) includes default reports for many common 

business needs. However, most organizations customize the default reports and add custom 

reports for specific needs. 

2.2. Report ownership 

System reports are available to all users. Individuals who own reports can share them with 

specific colleagues or teams, or can make the reports available to the organization, so that all 

users can use them. 

2.3. Report types 

Dynamics 365 Customer Engagement (on-premises) supports two types of reports: 

 SQL Server Reporting Services reports. These reports use SQL queries and filtered 

views to retrieve report data. Filtered views restrict the data to what is available to the 

security role of the person running the report. All the default reports included with 

Dynamics 365 Customer Engagement (on-premises) are SQL-based reports. 

You cannot access filtered views in Dynamics 365 for Customer Engagement apps 

because access to the SQL database is not supported. If you have a Dynamics 365 for 

Customer Engagement apps subscription, use Fetch-based reports for custom reporting. 

 Fetch-based Reporting Services reports. These reports use FetchXML queries that 

are proprietary to Dynamics 365 Customer Engagement (on-premises) instead of filtered 

views to retrieve data for reports. Reports that you create by using the Report Wizard in 

Dynamics 365 Customer Engagement (on-premises) are Fetch-based reports. 

 

 

 

The other reports can be: 

 Links to webpages 

 Static files 

 Dynamic Office Excel files that read data from the Dynamics 365 for Customer 

Engagement database 

For each report, you can edit the following properties: 
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 File name or URL 

 Display name 

 Description 

 Information about where the report displays in the user interface 

Security of data in reports 

All reports read Dynamics 365 Customer Engagement (on-premises) data from filtered views  

That filter the data based on the user's security role. Reports only display data that the person  

Running the report has permission to view. 

Options for creating new reports 

To create a new report, users with appropriate permissions can: 

 Add a file or a link to a webpage as a report. 

 Run the Report Wizard to create a new Reporting Services report. The Report Wizard can 

 Create table and chart reports, including drill-through reports and top N reports. 

 Write a new Fetch-based Reporting Services report.  

 

 

 

 

 

 

 

2.4. Options for modifying existing reports 

For existing reports, users with appropriate permissions can: 

 Organize reports into categories to control which views in the reports area display for each  

report. 

 Determine where a report is visible in the user interface, and edit other report properties. 

 Edit a report created with the Report Wizard. 

 Edit a default report. For example, if you customize Dynamics 365 Customer Engagement 

 (on-premises), you might need to modify labels or add or remove fields in default reports.  

More information: Report writing environment using SQL Server Data Tools. 

 Edit the default filter for a default report, a report created with the Report Wizard, or  

Other Reporting Services reports. 

 Create a one-time snapshot for a Reporting Services report or schedule a Reporting  

Services report to run at set intervals. Note that the Report Scheduling feature is currently only 

available with on-premises versions of Dynamics 365 Customer Engagement. 

https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/analytics/report-writing-environment-using-sql-server-data-tools
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 Share a personal report with other users, or make it available to everyone in your  

Organization. 

 Publish a report so that it is available for use with external applications, such as  

SharePoint or custom programs. 
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Self-Check -2 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. Determine where a report is visible in the user interface, and edit other report properties. 

2. Edit a report created with the Report Wizard. 

 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

 

 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Information Sheet 3 Distributing reports to appropriate person in a suitable 

format 

 

3.1.Overview of Distributing Reports 

Distributing reports automates the process of delivering updated content to report users. You 

can distribute reports once or at recurring intervals, such as daily, multiple times daily, weekly, 

or monthly. 

If you have the Distribute Reports capability, then you can distribute reports using the designer. 

Distributing reports automates the process of delivering updated content to report users. You 

can distribute reports once or at recurring intervals, such as daily, multiple times daily, weekly, 

or monthly. In addition, distributing reports gives you the ability to create a time event to 

generate reports during non-peak hours. 

 

Figure 3.1.Personal report 
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Self-Check -3 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. Distributing reports automates the process of delivering updated content to report users. 

2. If you have the Distribute Reports capability, then you can distribute reports using the 

designer. 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

 

 

 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Information Sheet 4 Using a wizard to create a simple form 

4.1. Creating wizard 

Access provides several quick-create form tools on the Create tab, each of which lets you 

create a form with a single click. However, if you want to be more selective about what fields 

appear on the form, you can use the Form Wizard instead. The wizard also lets you define how 

the data is grouped and sorted, and you can use fields from more than one table or query 

(provided that you specified the relationships between the tables and queries beforehand). 

You can create new forms quickly with the Form Wizard. You can use a new form immediately 

after creating it or choose to edit the form using the Form editor. 

The Form Wizard has two screens. The Basic screen lets you create new forms with a few 

simple operations. The Advanced screen lets you customize the form before you build it. 

 

Table 4.1.creating new form 
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Self-Check -4 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. Access provides several quick-create form tools on the Create tab, each of which lets 

you create a form with a single click. 

2. You can create new forms quickly with the Form Wizard. 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

 

 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Information Sheet 5 Opening existing database and modify records  

 

5.1. Opening data base 

An Access database consists of one or more tables that contain related information. Once 

you've created such an empty database, you could work your way through all of the tables to fill 

them with information. 

However, this could become tedious and confusing. It's hard to follow relationships between 

data in tables while you're trying to enter in data. Access input forms are a valuable tool for this. 

You can design input forms so you can enter data in a logical format. 

 

5.2.Modifyrecords 

This lesson will address the benefits of using forms in a database. You will review examples 

of different forms and form components. Finally, you will learn how to use forms to enter new 

records and view and edit existing ones. 

Forms are so popular because they're useful to the person asking for the information and to the 

person providing it. They are a way of requiring information in a specific format, which means 

the person filling out the form knows exactly which information to include and where to put it. 

 

Table 5.1.Record of table 

The you can't learn much just by glancing at these records because the ID numbers don't tell 

you much about the data they relate to. Plus, because you have to look at two tables just to 

view one order, you might have a difficult time even finding the right data. It's easy to see how 

viewing or entering many records this way could become a difficult and tedious task. 

 

 

https://www.lifewire.com/build-access-database-in-office-365-1019885
https://www.lifewire.com/creating-forms-in-microsoft-access-2013-1019959
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Table 5.Different types of records 

Modifying the record also would be easier because you wouldn't have to know any ID numbers 

to enter new data. When you're using a form, you don't have to worry about entering data into 

the right tables or in the right format—the form can handle these things itself. There's no need 

to go back and forth between tables because forms bring all of the information you need 

together in one place. 

Not only do forms make the data entry process easier for the user, but they also keep the 

database itself working smoothly. With forms, database designers can control exactly how 

users are able to interact with the database. They can even set restrictions on individual form 

components to ensure all of the needed data is entered and that it's all entered in a valid 

format. This is useful because keeping data consistent and organized is essential for an 

accurate and powerful database. 
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Self-Check -5 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. An Access database consists of one or more tables that contain related information. 

2. Modifying the record also would be easier because you wouldn't have to know any ID 

numbers to enter new data. 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

 

 

 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

https://www.lifewire.com/build-access-database-in-office-365-1019885
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Information Sheet 6 Rearrange objects within the form  

 

6.1. Align or arrange objects 

In Microsoft Office programs, you can quickly align objects (such as pictures, shapes, text 

boxes, SmartArt graphics, and WordArt. 

6.2. Aligning objects 

When you move objects in PowerPoint, alignment guides and spacing guides will appear 

around the objects to help you align them. However, if you have many different objects on a 

slide, it may be difficult and time consuming to get them perfectly aligned. Luckily, PowerPoint 

provides you with several alignment commands that allow you to easily arrange and position 

objects. 

6.3. Grouping objects 

You may want to group multiple objects into one object so they will stay together if they are 

moved or resized. This is often easier than selecting all of the objects each time you want to 

move them.Pictures, shapes, clip art, and text boxes can all be grouped together; 

however, placeholders cannot be grouped. If you will be grouping pictures, use one of the 

commands in the Images group on the Insert tab to insert pictures instead of the picture icon 

inside the placeholder. 

 

 

Table 6.1.Align object 
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Self-Check -6 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. When you move objects in PowerPoint, alignment guides and spacing guides will appear 

around the objects to help you align them. 

2. You may want to group multiple objects into one object so they will stay together if they 

are moved or resized. 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

 

 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Operation sheet-1 Create a Report Distribution 

 

OPERATIONTITLE:Creating a Report Distribution 

PURPOSE: To Create a Report Distribution 

EQUIPMENT TOOLS AND MATERIALS:-Desk top Computer, monitor, keyboard, mouse, 

hard disk, printer, cable, HDMI cable, CPU... 

PROCEDURES:- 

Step 1: Select Distributions in the left pane of the Distribute Reports window. 

Step 2.Select a report job, and click Schedule. The Schedule window is displayed. 

Step3.Click New to create a time event. The Specify Schedule Details window is displayed. 

Step 4.Specify whether the distribution should happen one time only or More than once.  

Step 5.If you select one time only, then select an Hour and a Minute for the distribution. 

Step 6.If you select More than once, then specify the details about when the distribution should 

occur. 

PRECAUTION: use computer safety as required. 

QUALITY CRITERIA:Create report distributionproperly. 
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Operation sheet-2 Creating form wizard 

 

OPERATIONTITLE:Creating form wizard 

PURPOSE:to Create form wizard 

EQUIPMENT TOOLS AND MATERIALS:-Desk top Computer, monitor, keyboard, mouse, 

hard disk, printer, cable, HDMI cable, CPU... 

PROCEDURES:- 

Step 1.On the Create tab in the Forms group, click Form Wizard. The wizard starts.  

Step 2.From the Tables/Queries drop-down list, select the table (or query) to base the form on. 

The fields for the selected table load in the Available Fields list box. 

Step 3.Move the fields to include on the form from the Available Fields list box to the Selected 

Fields list box. To do so, double-click a field name to move it or highlight the field name and 

click >. To move all fields at once, click >>.  

 

Step 4.Click Next >.  
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Step 5.Select the layout for the form. Your options are "Columnar", "Tabular", "Datasheet", and 

"Justified". 

Step 6.Click Next >.  

 

Step 7.Enter a title for the form. 

Step 8.Select an option for the view you want to open the form in. Your options are: 

Step 9.Open the form to view or enter information (opens in Form view). 

Step 10.Modify the form's design (opens in Design view). 

Step 11.Click Finish. 

PRECAUTION: use computer safety as required. 

QUALITY CRITERIA:Create form wizard properly. 
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Operation sheet-3 Opening existing  form  

 

OPERATIONTITLE:Opening existing form  

PURPOSE:To openexisting form 

EQUIPMENT TOOLS AND MATERIALS:-Desk top Computer, monitor, keyboard, mouse, 

hard disk, printer, cable, HDMI cable, CPU... 

PROCEDURES:- 

Step 1.Open your database, and locate the Navigation pane. 

Step 2.In the Navigation pane, locate the form you want to open. 

Step 3.Double-click the desired form. 

 

 

Step 4.It will open and appear as a tab in the Document Tabs bar. 
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PRECAUTION: use computer safety as required. 

QUALITY CRITERIA:Open form properly. 
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Operation sheet-4 Aligning two or more objects 

 

OPERATIONTITLE:Aligning two or more objects 

PURPOSE:To Aligntwo or more objects 

EQUIPMENT TOOLS AND MATERIALS:-Desk top Computer, monitor, keyboard, mouse, 

hard disk, printer, cable, HDMI cable, CPU... 

PROCEDURES:- 

Step 1.Click and drag your mouse to form a selection box around the objects you 

want to align. The Format tab will appear. 

 

 

Step 2.From the Format tab, click the Align command, then select Align Selected 

Objects. 

 

 

Step 3.Click the Align command again, then select one of the six alignment options. 
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Step 4.The objects will align based on the option you selected. 

 

PRECAUTION: use computer safety as required. 

QUALITY CRITERIA:Aligning two or more objects properly. 
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LAP-Test Practical Demonstration 

 

Project Title: Creating reports and forms 

 

Name:           ______________________                       Date:  ________________ 

Timestarted: _______________________ Timefinished:  ___________ 

 

Instructions: Perform the following task in 2 hour recommended time. 

Task 1: Create a Report Distribution 

Task 2:Create form wizard 

            Task 3.Open existing form 

            Task 4.Align two or more objects 
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This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics –  

 Accessing existing database and locate required records 

 Creating simple query and retrieve required information 

 Developing query with multiple criteria and retrieve required information 

 Selecting data and display appropriately 

This guide will also assist you to attain the learning outcome stated in the cover page. 

Specifically, upon completion of this Learning Guide, you will be able to – 

 Access existing database and locate required records 

 Create simple query and retrieve required information 

 Develop query with multiple criteria and retrieve required information 

 Select data and display appropriately 

 

Learning Instructions:  

8. Read the specific objectives of this Learning Guide.  

9. Follow the instructions described below  

10. Read the information written in the ―Information Sheets 1- 6‖. Try to understand what are 

being discussed.  

11. Accomplish the ―Self-checks1, 2, 3, 4, 5 and 6‖ in each information sheets on pages 4, 

11,14,19,23 and 26. 

12. Ask from your teacher the key to correction (key answers) or you can request your 

teacher to correct your work. (You are to get the key answer only after you finished 

answering the Self-checks).  

13. If you earned a satisfactory evaluation proceed to ―Operation sheets 1, 2 and 3 on pages 

28,29 and 30.and do the LAP Test on page 31‖.  However, if your rating is unsatisfactory, 

see your teacher for further instructions or go back to Learning Activity.  

14. After you accomplish Operation sheets and LAP Tests, ensure you have a formative 

assessment and get a satisfactory result; then proceed to the next LG. 

 

 

Instruction Sheet Learning Guide 45:   Retrieve information 
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Information Sheet 1 Accessing existing database and locate required records 

 

1.1. What is a database? 

Simply put a database is a structured body of related information. The software used to 

manage and manipulate that structured information is called a DBMS (Database Management 

System). A database is one component of a DBMS. You can think of a database simply as a 

list of information. A fine example is the white pages of the phone book. The each listing in the 

white pages contains several items of information – name, address and phone number – about 

each phone subscriber in a particular region (information). 

 All subscriber information shares the saEntities and Relationships The very basics of what we 

are trying to model are entities and relationships. Entities are the things in the real world that 

we will store information about in the database. For example, we might choose to store 

information about employees and the departments they work for. In this case, an employee 

would be one entity and a department would be another.  

The works-for relationship is usually a many-to-one relationship in this example. That is, many 

employees work for a single department, but each employee works for only one department. 

1.2. Relationship of data base 

Relationships are the links between these entities. For example, an employee works for a 

department. Relationships come in different degrees. They can be one-to-one, one-to-many (or 

many-to-one depending on the direction you are looking at it from), or many-to-many. A one-to-

one relationship connects exactly two entities. If employees in this organization had a cubicle 

each, this would be a one-to-one relationship.  

 

Figure 1.1.Relationship of data base 

 

1.3Locate and record of column database 

 Database tables, each column or attribute describes some piece of data that each record in 

the table has. The terms column and attribute are used fairly interchangeably, but a column is 
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really part of a table, whereas an attribute relates to the real-world entity that the table is 

modeling. In Figure 2 you can see that each employee has an employee, a name, a job, and a 

departmental. These are the columns of the employee table, sometimes also called the 

attributes of the employee table. 

Each row in the table represents a single employee record. You may hear these called rows, 

records, or tuples. Each row in the table consists of a value for each column in the table. 

This employee table stores employee IDs, names, jobs, and the department each employee 

works for. 

1.4. Locate specific records in a database 

 As your database grows, locating specific records will involve more than a quick glance at a 

datasheet. In this article, learn five ways to locate specific records based on your needs. 

Browse through all records you can browse through records by using the TAB key when you 

want to move through one record at a time, in order, to locate a specific record. You can also 

browse through records in a table in Datasheet view using the record navigation buttons. The 

record navigation buttons are available at the bottom of the table or form. 

The techniques that you can use to search and filter records are very useful for finding specific 

records for the case at hand. However, you might want to perform the same search or filter 

operation regularly. Instead of reproducing a set of search and filter steps every time, you can 

create a query.A query is a powerful and flexible way to locate specific records because it lets 

you perform customized searches, apply customized filters, and sort records. You can build 

your own queries to help you focus on specific records and to answer specific questions. Once 

created, a query can be saved and reused, and can also be used in building forms and reports.   

 

Figure 1.2.locate and record data base 
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Self-Check -1 Written test 

 

Direction I: Multiple choice items 

Instruction: Choose the best answer for the following questions and write the letter of your 

answer on the answer sheet provided in the next page. Use bold letter. (2 points each). 

 

1. You can browse through records by using _____________ key. 

A. TAB                               C. Delete 

B. ALT                               D. None 

2. The -----buttons are available at the bottom of the table or form. 

 A. Record navigation C. A&B 

 B. Save button                     D. All 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

Choose  

1____ 

2____ 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Information Sheet 2 Creating simple query and retrieve required information 

 

A query is a request for data results, for action on data, or for both. You can use a query to 

answer a simple question, to perform calculations, to combine data from different tables, or 

even to add, change, or delete table data .A query is a derived item in the database meant  to 

answer specific questions that relate to the information in the database. It is the means to 

r2.1Types of Queries 

A.Select Query  

 The select query is the simplest type of query and because of that, it is also the most 

commonly used one in Microsoft Access databases.  

 A select query is the most common type of query.   

 It retrieves data from one or more tables and displays the results in a datasheet where 

you can update the records (with some restrictions).   

 You can also use a select query to group records and calculate sums, counts, averages, 

and other types of totals.  

 It can be used to select and display data from either one table or a series of them 

depending on what is needed.  

 In the end, it is the user-determined criteria that tell the database what the selection is to 

be based on.  

 After the select query is called, it creates a "virtual" table where the data can be 

changed, but at no more than one record at a time.  

B.Action Query 

Action queries are very popular in data management because they allow for many records to 

be changed at one time instead of only single records like in a select query. 

 When the action query is called, the database undergoes a specific action depending on 

what was specified in the query itself.  

 This can include such things as creating new tables, deleting rows from existing ones 

and updating records or creating entirely new ones.  

Four kinds of action queries are:  

C.Append Query  

 An append query adds a group of records from one or more tables to the end of one or 

more tables. For example, suppose that you acquire some new customers and a 

database containing a table of information on those customers.  
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 To avoid typing all this information into your own database, you'd like to append it to 

your Customers table. 

D.Delete Query   

 A delete query deletes a group of records from one or more tables. For example, you 

could use a delete query to remove products that are discontinued or for which there are 

no orders. With delete queries, you always delete entire records, not just selected   fields 

within records 

E.Make Table Query   

 As the name suggests, it creates a table based on the set results of a query. A make-

table query creates a new table from all or part of the data in one or more tables. Make-

table queries are helpful for creating a table to export to other Microsoft Access 

databases or a history table that contains old records.   

F.Update Query   

 Allows for one or more field in your table to be updated. Ø An update query makes 

global changes to a group of records in one or more tables.  Ø For example, you can 

raise prices by 10 percent for all dairy products, or you can raise salaries by 5 percent 

for the people within a certain job category. With an update query, you can change data 

in existing tables. 

 

Parameter Query  

 In Microsoft Access, a parameter query works with other types of queries to get 

whatever results you are after.   

 This is because, when using this type of query, you are able to pass a parameter to a 

different query, such as an action or a select query.   

 It can either be a value or a condition and will essentially tell the other query specifically 

what you want it to do.  

 It is often chosen because it allows for a dialog box where the end user can enter 

whatever parameter value they wish each time the query is run. The parameter query is 

just a modified select query.  

 A parameter query is a query that when run displays its own dialog box prompting you 

for information, such as criteria for retrieving records or a value you want to insert in a 

field.   

 You can design the query to prompt you for more than one piece of information; for 

example, you can design it to prompt you for two dates.   

 Access can then retrieve all records that fall between those two dates.  
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 Parameter queries are also handy when used as the basis for forms, reports, and data 

access pages.     

 

 

 

 

 

 

 

 

 

 

Self-Check 2 Multiple choices 

 

Direction I: Multiple choice items 

Instruction: Choose the best answer for the following questions and write the letter of your 

answer on the answer sheet provided in the next page. Use bold letter. (2 points each). 

1. _____________ is a request for data results, for action on data, or for both 

   A. A query                          C. Form 

   B. Table                             D. None 

2.______________deletes a group of records from one or more tables 

A. A delete query C. Parameter query 

B. Append Query                   D.ALL 

3. Allows for one or more field in your table to be updated. 

 A. Update Query  C. Select query              

B. Parameter query                  D.ALL 

 

Note: Satisfactory rating – 3 and above points          Unsatisfactory - below 3 points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

Choose  

1____ 

Score = ___________ 

Rating: ____________ 
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2____ 

3.___ 
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Information Sheet 3 Develop query with multiple criteria and retrieve 

 

3.1. Introduction to query criteria  

A criterion is similar to a formula — it is a string that may consist of field references, operators, 

and constants. Query criteria are also referred to as expressions in Access. The following 

tables show some sample criteria and explains how they work. 

Criteria Description >25 and <50 this criterion applies to a Number field, such as Price or 

UnitsinStock. It includes only those records where the Price or UnitsinStock field contains a 

value greater than 25 and less than 50. DateDiff ("yyyy", [BirthDate], Date ()) > 30 this criterion 

applies to a Date/Time field, such as BirthDate. Only records where the number of years 

between a person's birthdate and today's date is greater than 30 are included in the query 

result.  Is Null this criterion can be applied to any type of field to show records where the field 

value is null.   

As you can see, criteria can look very different from each other, depending on the data type of 

the field to which they apply and your specific requirements. Some criteria are simple, and use 

basic operators and constants. Others are complex, and use functions, special operators, and 

include field references.  

This topic lists several commonly used criteria by data type. If the examples given in this topic 

do not address your specific needs, you might need to write your own criteria. To do that, you 

must first familiarize yourself with the full list of functions, operators, special characters, and the 

syntax for expressions referring to fields and literals.  

Here, you will see where and how you add the criteria. To add criteria to a query, you must 

open the query in Design view. You then identify the fields for which you want to specify 

criteria. If the field is not already in the design grid, you add it by either dragging it from the 

query design window to the field grid, or by double-clicking the field (Double-clicking the field 

automatically adds it to the next empty column in the field grid.). Finally, you type the criteria in 

the Criteria row. 

Criteria that you specify for different fields in the Criteria row are combined by using the AND 

operator. In other words, the criteria specified in the City and BirthDate fields are interpreted 

like this: 
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The City and Birth Date fields include criteria.  

 Only records where the value of the City field is Chicago will satisfy this criterion. 

 Only records of those who are at least 40 years old will satisfy this criterion. 

 Only records that meet both criteria will be included in the result.  

What if you want only one of these conditions to be met? In other words, if you have alternate 

criteria, how do you enter them? If you have alternate criteria, or two sets of independent 

criteria where it is sufficient to satisfy one set, you use both the Criteria and the or rows in the 

design grid.   
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Self-Check 3 Multiple choices 

 

Direction I: Multiple choice items 

Instruction: Choose the best answer for the following questions and write the letter of your 

answer on the answer sheet provided in the next page. Use bold letter. (2 points each 

1 - A criterion is similar to__________________  

   A. formula                       C. A&B          

   B. String                          D .ALL 

2._____________is a string that may consist of field references, operators, and constants 

A. Criterion                         B. Value   

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

Choose  

1____ 

2____ 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Information Sheet 4 Select data and display appropriately 

 

1.1. Selection of data 

 

Data files such as word documents can be kept on a computer for future uses such as editing 

and printing. To find documents you will need to store them in an organised fashion—in the 

same way you might file documents like lesson notes, bills, and letters and bank statements at 

home. 

Just as you might use folders to organise your personal or business documents, you also store 

your computer documents in folders. A folder is only a device for grouping files in the same 

location, not a data file.  

Folders and files can be stored on a computer‘s desktop or on a storage device which will be 

able to store hundreds or thousands of documents. Folders can be created or moved so that 

they sit within another folder, and so on. 

 

1.2. Data selection 

It is defined as the process of determining the appropriate data type and source, as well as 

suitable instruments to collect data. The primary objective of data selection is the determination 

of appropriate data type, source, and instrument(s) that allow investigators to adequately 

answer research questions.  

a. The function of displaying data 

 

 Displaying data in research is the last step of the research process.  It is important to display 

data accurately because it helps in presenting the findings of the research effectively to the 

reader. To make the findings more visible and make comparisons easy. 
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Self-Check 4 Multiple choices 

 

Direction I: Multiple choice items 

Instruction: Choose the best answer for the following questions and write the letter of your 

answer on the answer sheet provided in the next page. Use bold letter. (2 points each 

1. __________is defined as the process of determining the appropriate data type and Source        

A. Data selection         C. A&B 

B. Data processes        D.ALL 

2.____________ in research is the last step of the research process. 

A. Data selection         C. Displaying data 

B. Data processes        D.ALL 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

Choose  

1____ 

2____ 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Operation sheet-1 Accessing &Locating Records   

 

OPERATIONTITLE:Accessing &Locating Records   

PURPOSE: To Access &Locate Records   

EQUIPMENT TOOLS AND MATERIALS:-Desk top Computer, monitor, keyboard, mouse, 

hard disk, printer, cable, HDMI cable, CPU... 

PROCEDURES:- 

You can browse through records by using the TAB key when you want to move through one 

record at a time, in order, to locate a specific record. You can also browse through records in a 

table in Datasheet view using the record navigation buttons. The record navigation buttons are 

available at the bottom of the table or form. 

 

 Step 1.Go to the first record  

 Step 2. Go to the previous record  

 Step 3. Current Record box  

 Step 4. Go to the next record 

Step 5. Go to the last record  

 Step 6. Open a new (blank) record 

 Step 7. Filter indicator  

 Step 8. Search box 

PRECAUTION: use computer safety as required. 

QUALITY CRITERIA:Accessing &Locating Recordsproperly. 
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Operation sheet-2 Creating Simple Query to Retrieve Information 

 

OPERATIONTITLE:Creating Simple Query to Retrieve Information 

PURPOSE:To Create Simple Query & Retrieve Information 

EQUIPMENT TOOLS AND MATERIALS:-Desk top Computer, monitor, keyboard, mouse, 

hard disk, printer, cable, HDMI cable, CPU... 

PROCEDURES:- 

Step1.On the Ribbon, you can click the Create tab and, in the Other section, click Query 

Wizard. This would display the New Query dialog box: 

Step 2.On the New Query dialog box, you can click Simple Query Wizard and click OK. The 

first page of the Simple Query Wizard expects you to choose the origin of the query as a table 

or an already created query. After selecting the table or query, the second page of the wizard 

would present the fields of that list and you can select those you want: 

The next page of the wizard allows you to specify the name of the query: 

 

PRECAUTION: use computer safety as required. 

QUALITY CRITERIA:Creating Simple Query to Retrieve Information properly. 
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Operation sheet-3 Creating  Query in Design view 

 

OPERATIONTITLE:Creating Query in Design view 

PURPOSE:To Create Query in Design view 

EQUIPMENT TOOLS AND MATERIALS:-Desk top Computer, monitor, keyboard, mouse, 

hard disk, printer, cable, HDMI cable, CPU... 

PROCEDURES:- 

Step 1.To display a query in Design View, from the Navigation Pane, you can right-click a 

query and click Design View  

Step 2.To start designing a new query, in the other section of the Create tab of the Ribbon, 

click Query Design This would display the Show Table dialog box that allows you to specify the 

table or query that holds the fields you want to use in the intended query. 

 

Step 3.If the Show Tables dialog box is closed or for any reason you want to display it:  In the 

Query Setup section of the Design tab of the Ribbon, you can click the Show Table. 

 

Step 4.You can right-click anywhere on the query window and click Show Table...  
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Step 5.When a query is displaying in Design View, the Design tab of the Ribbon displays the 

buttons used for a query:   

 

Step 6.The Query window allows you to design and manage various aspects of a query. You 

can right-click the title bar of the Query window to access a menu: 

 

 

 

 

 

 

Step 7.One of the operations you can perform on the Query window consists of resizing its top 

and bottom sections by dragging the splitter bar up or down: 
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PRECAUTION: use computer safety as required. 

QUALITY CRITERIA:Creating Query in Design view properly. 
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LAP-Test Practical Demonstration 

 

Project Title: Retrieving information 

 

Name:           ______________________          Date:  ________________ 

Timestarted: _______________________ Timefinished:  ___________ 

 

Instructions: Perform the following task in 2 hour recommended time. 

            Task 1: Access &LocateRecords   

Task 2: Create Simple Query & Retrieve Information 

            Task 3.Create Query in Design view 
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Instruction sheet Learning guide 46:Printing  documents 

 

This learning guide is developed to provide you the necessary information regarding the following 

content coverage and topics –  

 Previewing document/ spreadsheet in print preview  

 Selecting basic print settings/ options 

 Printing word and spreadsheet documents 

  Submitting the spreadsheet to appropriate person  

This guide will also assist you to attain the learning outcome stated in the cover page. Specifically, 

upon completion of this Learning Guide, you will be able to – 

 Preview document/ spreadsheet in print preview mode 

 Select basic print settings/ options 

 Print word and spreadsheet documents 

 Submit the spreadsheet to appropriate person for approval or feedback 

 

 Learning Instructions:  

1. Read the specific objectives of this Learning Guide.  

2. Follow the instructions described below  

3. Read the information written in the ―Information Sheets 1- 6‖. Try to understand what are 

being discussed.  

4. Accomplish the ―Self-checks1, 2, 3, 4, 5 and 6‖ in each information sheets on pages 4, 

11,14,19,23 and 26. 

5. Ask from your teacher the key to correction (key answers) or you can request your teacher 

to correct your work. (You are to get the key answer only after you finished answering the 

Self-checks).  

6.If you earned a satisfactory evaluation proceed to ―Operation sheets 1, 2 and 3 on pages 

28,29 and 30.and do the LAP Test on page 31‖.  However, if your rating is unsatisfactory, see 

your teacher for further instructions or go back to Learning Activity.  

7. After you accomplish Operation sheets and LAP Tests, ensure you have a formative 

assessment and get a satisfactory result; then proceed to the next LG. 
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Information Sheet 1 Previewing document/ spreadsheet in print preview  

 

1.1. Print a document or file 

The quickest way to print a document or file is to print using Windows. You don't have to open 

any programs or change any settings. Right-click the file you want to print, and then click Print. 

Windows will launch the program that created the file and send it to your default printer. 

 

Once your document or photo has started to print, you can pause or cancel it via the print 

queue.The print queue shows you what's printing or waiting to print. It also displays handy 

information such as job status, who's printing what, and how many unprinted pages remain. 

 

 

Table 9.1.print file 

 

 

 

mshelp://windows/?id=ba753ff8-2a2f-44e2-9f56-3c9631dab37e#gtmt_print_queue_def
mshelp://windows/?id=ba753ff8-2a2f-44e2-9f56-3c9631dab37e#gtmt_print_queue_def
mshelp://windows/?id=ba753ff8-2a2f-44e2-9f56-3c9631dab37e#gtmt_print_queue_def


                                                            

Page 213 of 226 
 

Federal TVET Agency 
Author/Copyright  

Irrigation and drainage construction 
Level -II 

Version -2 

September 2019 

 

Self-Check -1 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. The quickest way to print a document or file is to print using Windows. 

2. The print queue shows you what's printing or waiting to print. 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Information Sheet 2 Selecting basic print settings/ options 

 

2.1. Change your default printer 

If you regularly use multiple printers, you can pick one as your default printer. Windows and 

other programs then automatically use that device whenever you print.  

 

A default printer doesn't have to be an actual physical device. Depending on your computer, 

you might have the option to send documents as faxes, or to save them as PDF or XPS files 

when you print. You can change your default printer setting at any time. 

 

It is likely that there are several printers that you have access to, especially in a work 

environment. You may want to select a printer other than the default printer because it provides 

different functionality –.g. borderless, color laser, because it has different stock loaded (paper, 

envelopes, labels), or simply because your default printer is currently out of action. 

 

 

Figure 2.1.printer options 

mshelp://windows/?id=be27e4fc-0da6-4ffb-a100-216bcc8e2879#gtmt_default_def
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Self-Check -2 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. If you regularly use multiple printers, you can pick one as your default printer. 

2. A default printer doesn't have to be an actual physical device. 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

 

 

 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

mshelp://windows/?id=be27e4fc-0da6-4ffb-a100-216bcc8e2879#gtmt_default_def
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Information Sheet 3 Printing word and spreadsheet documents 

 

3.1. Printing from Word  

There is a preview of the current page shown on the right. The 'copies' box allows you to 

specify the number of copies. The printer allows you to change the printer as a business may 

have different printers for different situations.   

 

 

 

Table 3.1.printing from a word. 

 

Settings allow you to print all pages, the current page as shown on the right, or a custom range 

of pages, or the document properties. By clicking on the arrows on the lower right side the 

current page can be changed for the ―Print current page‖ option. If the selected printer has the 

capabilities, there will be an option to allow double-sided or duplex printing.   

'Collated' applies when there is more than one copy to print and the copy has more than one 

page. Assume that four copies of a document that has 3 pages and double-sided printing has 

been selected, which means there will be two pieces of paper with printing on three sides.  

 



                                                            

Page 217 of 226 
 

Federal TVET Agency 
Author/Copyright  

Irrigation and drainage construction 
Level -II 

Version -2 

September 2019 

 

Collated will print the entire document four times. Uncollected will print four copies of the first 

page and second page on one piece of paper and then four copies of the last page. 

'Orientation' (Portrait or Landscape) determines how the page will be laid out.  

Portrait has the long edge on the vertical, much like a portrait painting, or this page on the 

computer screen. Landscape will have the short edge on the vertical and the long edge across, 

much like a landscape painting. Margins provide the opportunity to set the beginning and 

ending position of text on the page from the edge of the paper. 

3.2. Printing excel  

Excel does not paginate a document as Word does until printing. It is therefore important to 

check the page breaks before sending a document to the printer. To determine the page breaks 

simply open the print options and then click 'Home' and Excel will show where the page breaks 

will occur. The print preview in the Print Options will allow you to check that the page breaks 

are appropriate.  

3.3. Printing from Access  

Printing from Access has many of the same approaches as the other two Microsoft Products. 

Open the Customer's database.  

'Margins' will allow you to set the page margins. 'Size' will allow you to pick different size paper, 

and this will change the amount of data that can be printed on the page. Page Setup will allow 

you to select the printer and the margins. The print button will send the document to the 

currently selected printer. This will export the table into an Excel format file that can be read 

and edited within Excel. 
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Self-Check -3 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. There is a preview of the current page shown on the right. 

2. Printing from Access has many of the same approaches as the other two Microsoft 

Products. 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2_____ 

 

 

 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Information Sheet 4 Submit the spreadsheet to appropriate person  

 

4.1. Introduction to spread sheet 

This is the ability to use a software application designed to record data in rows and columns, 

perform calculations with numerical data and present information using charts and graphs.  

This unit is about the skills and knowledge required by an IT user to select and use a wide 

range of advanced spreadsheet software tools and techniques to produce, present and check 

complex and non-routine spreadsheets. Spreadsheet software tools and techniques will be 

described as advanced because: 

 • The range of data entry, manipulation and outputting techniques will be complex and non-

routine 

 • The tools, formulas and functions needed to analyses and interpret the required information 

require complex and non-routine knowledge and understanding (for example, data restrictions, 

data validation using formula, pivot tables, data maps); and  

• The user will take full responsibility for setting up and developing the functionality of the 

spreadsheet. 

4.2.Appropriate person participated in submission 

 Authorized business representative 

 client 

 Supervisor. 
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Self-Check -4 True/False 

 

Direction I:True/False 

Instruction:Say True for correct statement and False for wrong statement. (2 points 

each). (2 points each). 

1. The range of data entry, manipulation and outputting techniques will be complex and non-

routine. 

2. The user will take full responsibility for setting up and developing the functionality of the 

spreadsheet. 

3.The ability to use a software application designed to record data in rows and columns. 

 

Note: Satisfactory rating – 2 and above points           Unsatisfactory - below 2 points  

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

True/False 

1____ 

2____ 

3.____ 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 
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Operation sheet-1 Printing document 

 

OPERATIONTITLE:Printing document 

PURPOSE: To Print document 

EQUIPMENT TOOLS AND MATERIALS:-Desk top Computer, monitor, keyboard, mouse, 

hard disk, printer, cable, HDMI cable, CPU... 

PROCEDURES:- 

Step 1.Click file 

Step 2.Click to open Devices and Printers. 

Step 3.Select your printer's icon and then click see what's printing on the command bar. 

 

 

 

PRECAUTION: use computer safety as required. 

QUALITY CRITERIA:Print a document properly. 

shortcut:%25systemroot%25\system32\control.exe%20/name%20Microsoft.DevicesAndPrinters
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Operation sheet-2  Cancelling print document 

 

OPERATIONTITLE:Cancelling print document 

PURPOSE: To Cancel print document 

EQUIPMENT TOOLS AND MATERIALS:-Desk top Computer, monitor, keyboard, mouse, hard 

disk, printer, cable, HDMI cable, CPU... 

PROCEDURES:- 

To cancel all print jobs for a printer, you must have permission to manage documents on the 

printer. 

Step 1.Click to open Devices and Printers. 

Step 2.Open the print queue by selecting your printer's icon and then clicking See what's 

printing on the command bar. 

Step3.Click the Printer menu, click Cancel All Documents, and then click yes to confirm.  

 

PRECAUTION: use computer safety as required. 

QUALITY CRITERIA:Cancel print document properly. 

 

 

 

 

 

 

 

 

 

 

mshelp://windows/?id=4160f29b-0ca6-4837-9276-3a0e3d8ba8fe#gtmt_permissions_def
shortcut:%25systemroot%25\system32\control.exe%20/name%20Microsoft.DevicesAndPrinters
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LAP-Test Practical Demonstration 

 

Project Title: Printing documents 

Name:           ______________________                       Date:  ________________ 

Time started: _______________________ Time finished:  ___________ 

 

Instructions: Perform the following task in 2 hour recommended time. 

Task 1: Print a document 

Task 2:Cancel print document 
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